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Welcome to URL Manager Pro
How many bookmarks do you have by now?

Since the early days of the Internet, users have been able to keep address lists and the like of people 
and places on the Net. Today, nearly all of today's popular Internet software has some way of helping 
you remember and keep track of your online affairs. 

Web browsers have bookmarks or favorites, FTP clients have shortcuts, E-mail programs have 
address books, remote host (Telnet) applications have connection lists, newsreaders remember which 
newsgroups you are subscribed to. What these programs do, they do very well. If you are comfortable 
using the facilities provided by each one, then please continue to use them. 

However, at some point, you may find that keeping your personal data in various forms in different 
programs becomes difficult to manage. New versions are released, but you aren't sure you want to 
upgrade without testing them. Or you need to occasionally use a different program for compatibility's 
sake. Or you need to abandon one program for another. 

Moreover, with the ongoing exponential growth of the Internet, many people are finding that the built-
in bookmark capabilities of today's Web browsers are just not good at handling the number of URLs 
that most people want to maintain. 

URL Manager Pro: A unified solution

URL Manager Pro solves many of the problems associated with keeping track of your Internet 
addresses. I've designed URL Manager Pro from the ground up to make it easy for you to manage 
thousands of URLs. UMP offers you an array of powerful features for collecting, manipulating, and 
using very large collections of URLs. Not just URLs of Web pages, but also the URLs of E-mail 
addresses, news servers, FTP sites, Telnet hosts, and more. 

Best of all, URL Manager Pro works in close conjunction with your Internet applications, allowing 
you to save URLs to and open URLs from URL Manager Pro from within these programs. URL 
Manager Pro works as a drop-in replacement for your Web browser's Bookmark function, your E-mail 
program's address book, your newsreader's subscription list, your FTP program's host list, etc. With 
URL Manager Pro, you can easily create your own menus of Bookmarks within your Internet 
applications, putting your URL Manager Pro Bookmarks just a mouse click away. 

With URL Manager Pro, you store all your URLs in one location. This means that you don't have to 
take sides in the 'browser battles'; you can continue to use both Netscape Navigator and Microsoft 
Internet Explorer side by side without committing yourself to one or the other. And you can try out 
newcomers as they appear, such as OmniWeb, iCab and Opera. 

URL Manager Pro is especially useful for people who access the Internet from different computers: 
home, work, computer lab, PowerBook. 

http://www.omnigroup.com/applications/omniweb/
http://www.icab.de/
http://www.opera.com/


As many thousands of satisfied URL Manager Pro users worldwide have discovered, URL Manager 
Pro is your ideal partner for surfing the Web. 

Alco Blom 

PS: may I ask you to have a look at another shareware application of mine? It is called Web 
Confidential and the most powerful password manager for the Macintosh that is available. It uses 
industrial strength encryption to protect all of your confidential data. It is a database for not only 
passwords, but also for things like PIN codes and credit card numbers. Furthermore, we also have a 
Windows and Palm version with associated Macintosh Conduit. 

http://www.web-confidential.com/
http://www.web-confidential.com/


Installation

Requirements

URL Manager Pro 3.0 requires Mac OS X or Mac OS 9. URL Manager Pro 2.8 is available for Mac 
OS 8 users. The application size of URL Manager Pro 3.0 is around 2 Mb, including help books. 

Installing

There is only but one step: 

●     On Mac OS X: put the URL Manager Pro application into the Applications folder. 
●     On Mac OS 9: put the URL Manager Pro application into the Applications (Mac OS 9) folder. 

Note: on Mac OS X, you will also want to install the Mondriaan menu extra or 'menulet'. On Mac OS 9, you will also 
want to install the Mondriaan Control Strip Module. 

For more information, go to the Mondriaan Web Page. 

Note: You will also want to drag & drop the Contextual Menu Manager (CMM) Plug-in named Add Bookmark, found 
in the Add-Ons folder of the URL Manager Pro folder, to the Contextual Menu Items folder. Its full path is: 

●     On Mac OS X: ~/Library/Contextual Menu Items/ 
●     On Mac OS 9: System Folder:Contextual Menu Items: 

For more information, go to the Add Bookmark CMM Plug-in Web Page. 

To use URL Manager Pro, simply double-click the application icon. 

When URL Manager Pro is first run, it installs the Shared Menus Component. If URL Manager Pro 
fails to install the component, please install the component manually. You can find the Shared Menus 
Component in the URL Manager Pro folder. Its full path needs to be: ~/Library/Components/ (see 
below).

 

Secondly, I strongly advice you store all your Bookmark files in a folder named Bookmarks in your 
Documents folder. The Documents folder always exists and was created by your Mac OS install. 
Please create a Bookmarks folder in your Documents folder. 

http://www.url-manager.com/mondriaan.html
http://www.url-manager.com/cmm.html


Furthermore, I suggest your create two more folders in your Bookmarks folder. One named Cabinet 
and one named Startup Items. Put your main bookmark file in the folder Startup Items and your 
other Bookmark files in the Cabinet folder. 

Below you can see how your heirarchy of Bookmark files should look like: 

 

The URL Manager Pro folder includes a folder called Startup Items containing a Bookmark file called 
Sample. Sample contains a small collection of Bookmarks, which are used in the tutorial Getting 
Started. These Bookmarks will also be useful to help you get started exploring the Web with URL 
Manager Pro. 

Please move the file Sample to the Startup Items folder as defined in the above hierarchy when you 
want to follow the Getting Started tutorial. 

User's Guide 

The User's Guide is part of the URL Manager Pro package. Choose the commands: 

●     URL Manager Pro Help 
●     Shared Menus Help 

from the Help menu in URL Manager Pro. 

However, the Help Viewer is not a very good tool to print the User's Guide. Fortunately, a version in 
Acrobat PDF format is also available. 

Memory considerations on Mac OS 9

http://www.url-manager.com/userguide.pdf


URL Manager Pro runs in a memory partition of around 2048K. If you have large Bookmark files, or 
want to have many Bookmark files open at the same time, you can increase the memory partition size. 
To check URL Manager ProÕs memory usage, select Environment Info from the File menu. 

URL Manager Pro works with popular Internet applications, including Netscape 4.x, Microsoft 
Internet Explorer, iCab and Opera. Because URL Manager Pro is not an extension to your Internet 
applications, but a standalone program, it does not consume memory when you are not using it. 

Application Defaults
URL Manager Pro uses as Web browser the Preferred Browser setting of the Mac OS. By default, this 
is Microsoft Internet Explorer. This setting can be overridden in the URL Manager Pro Preferences 
Window (see Preferences). 



Support for URL Manager Pro
Mailing List
The best source of technical support is the URL Manager Pro discussion list. Product update 
announcements are also posted here. 

To subscribe to URL Manager Pro discussion list, send a message to:

    URL-Manager-Pro-Talk-on@maclaunch.com

To make changes in your subscription, go here:

     http://www.url-manager.com/change.html 

Support
Please read the FAQ first. 

You can contact technical support at:

    support@url-manager.com

Foreign Language Versions
The foreign language versions of URL Manager Pro are available from the Home Page. The 
translators of URL Manager Pro are:

Language Translator Email address

Japanese Chris Li chrisli@kagi.com

Français Philippe Gruchet acm@kagi.com

Deutsch Matthias Kahlert mkahlert@kagi.com

Italiano Massimo Rotunno info@italiaware.net

Español Alberto Canto traduccion@teleline.es

mailto:URL-Manager-Pro-Talk-on@maclaunch.com
http://www.url-manager.com/change.html
http://www.url-manager.com/faq.html
mailto:support@url-manager.com
mailto:chrisli@kagi.com
mailto:acm@kagi.com
mailto:mkahlert@kagi.com
mailto:info@italiaware.net
file:///HD/Documents/URL%20Manager%20Pro%20Help/traduccion@teleline.es


The Concept of Shareware
URL Manager Pro is distributed under the so-called shareware principal. You have a trial period of 
thirty days to use URL Manager Pro to see whether it suits your needs. If you continue to use the 
program beyond thirty days, you are expected to pay a modest registration fee of $25 or €28. Within 
this trial period, you have full access to all of URL Manager Pro's features with the following 
restrictions: 

●     The Sort command is disabled 
●     The Grab All command is disabled 
●     On Mac OS X, a watermark is painted across a window 
●     You can scan a text document for URLs only once per session 
●     You are limited to adding five bookmarks via the Shared Menus feature 

Note: Adding bookmarks with the Add Web Page command in the Bookmarks menu of URL 
Manager Pro is not limited. 

After 30 days of use, the following restriction is activated: 

●     The Save to Browser command will be disabled

Upon payment of the registration fee, you will be issued a registration key, which removes these 
restrictions. Payment of the registration fee entitles you to all subsequent incremental upgrades. In 
addition, the wishes of registered users will be taken into account in future enhancements of the 
program. 

Although freely distributed via the Internet and on CD-ROM collections, URL Manager Pro is not 
public domain software; it is commercial software, which is professionally developed and supported. 
It represents many hours of work by its developer, whose primary source of income is derived from 
the development of shareware software for the Mac. Your registration payment ensures the continued 
viability of high-quality software developed by independent developers committed to the Mac. 

We trust that you will honour the shareware concept and register URL Manager Pro if you continue to 
use it. 

Ordering URL Manager Pro via Kagi

You can register URL Manager Pro ($25 or €28) on the WWW using this URL: 

    Kagi Web Store 

Ordering URL Manager Pro via PayPal

http://order.kagi.com/?AB&S


You can also register URL Manager Pro on the WWW via PayPal: 

    Pay via PayPal 

Ordering URL Manager Pro in Europe

Besides paying via Kagi using a credit card, you can also register URL Manager Pro by making a 
bank transfer. 

    Pay via bank transfer 

http://www.url-manager.com/paypal.html
http://www.url-manager.com/order.html


Getting Started with URL Manager Pro
Introduction

The Getting Started section contains a tutorial to help you get up to speed quickly using URL Manager Pro. 
In this tutorial, you will be introduced to the following topics: 

●     Launching Web pages
●     Adding Bookmarks to URL Manager Pro
●     Organizing your Bookmarks
●     Launching URL Manager Pro automatically

Tip: This tutorial is also available as an Acrobat PDF document on the Web. Its URL is:

<http://www.url-manager.com/tutorial.pdf> 

Tip (Mac OS 9 only): If you are new to the Mac, you might want to switch on Balloon Help. Balloon Help 
provides interactive help with many of the commands URL Manager Pro. 

To switch on Balloon help, select the Show Balloons command from the Help menu. Balloon Help will now be displayed in 
URL Manager Pro. To switch Balloon help off, select the Hide Balloons command. 

The Sample file

The follow the tutorial, locate the Bookmarks file 'Sample', which is in a folder named Startup Items in the 
URL Manager Pro folder. This contains a collection of Bookmarks. 

Note: Bookmarks contain Universal Resource Locators (URLs), the format in which Internet addresses is 
stored. A URL is represented in URL Manager Pro as a Bookmark. 

By exploring this sample collection Bookmarks, you will get a sense of the power and versatility of URL 
Manager Pro. Naturally, as soon as you familiarise yourself with the way the program works, you will want 
to start your own collection of Bookmarks. 

Launching Web pages

You can launch Web pages from Bookmarks stored in URL Manager Pro in one of three ways. The first way 
is by opening a bookmark from within URL Manager Pro. The second way is by using URL Manager Pro's 
Shared Menu feature for opening a Web page from within your Web browser. A third way is by using Drag 
& Drop. These three approaches each have their own advantages and are described below. 

Opening a bookmark from URL Manager Pro
A good place to start learning how to use URL Manager Pro is by going to the URL Manager Pro home page. 
URL Manager Pro is updated on a regular basis, and it is possible that there is a newer version available than 
the one you have, particularly if you obtained your copy on CD-ROM. It is always a good idea to use the 
latest version of URL Manager Pro. 

http://www.url-manager.com/tutorial.pdf


Open the Sample file and look at the Tutorial folder, the top folder in the Sample document window. You 
will find three bookmarks. Double-click on the first bookmark, called URL Manager Pro's Home Page. 

 

If your Web browser isn't running, URL Manager Pro will launch it. If your browser is running, URL 
Manager Pro will try to open this Web page in it. If you are not connected to the Internet, your Web browser 
will alert you that it cannot make a network connection. In this case, you should start your PPP dialer or 
whatever other program you use to connect to the Internet. 

If you are connected to the Internet, your Web browser should load the URL Manager Pro Home Page. It may 
take several seconds to load completely. Once the URL Manager Pro Home Page is loaded, take a moment to 
view the contents of this page. You'll find it offers links to various useful things, such as the latest version of 
URL Manager Pro in various languages, documentation, support addresses, and the like. 

To find out which version of URL Manager Pro you have, go to the Apple menu and select About URL 
Manager Pro... A window will be displayed in which the version number is shown. 

If a later (that is, a higher-numbered) version of URL Manager Pro is available on our Web site, click on a 
download link and you will be prompted to download it to your computer. 

Once the file transfer has been completed, exit URL Manager Pro, open the file you downloaded, and install 
the newer version of URL Manager Pro by replacing the application in the URL Manager Pro folder with the 
newer version. Restart URL Manager Pro. You are now up-to-date! 

We recommend you check the URL Manager Pro Web site regularly for new versions and additional useful 
information about URL Manager Pro and our related products. 

Opening Web pages from within URL Manager Pro is a good way to start surfing the Web. However, if you 
have already opened your Web browser and have been surfing for some time, you may find it more 
convenient to open a Web page, whose Bookmark you stored in URL Manager Pro, from within your 
browser. You will learn how to do that in the next section. 

Opening a Web page from within your browser
URL Manager Pro uses a sophisticated feature of the Mac operating system called Shared Menus to 
automatically install its own menu in your Web browser and other Internet applications. Called the Diamond 
menu, because it has an icon in the shape of a diamond, it contains a number of useful URL Manager Pro 
commands, which allow you to control URL Manager Pro from within your browser and access the 
bookmarks you have saved in it. 

Below you see Microsoft Internet Explorer's menu bar with URL Manager Pro's Diamond menu and Sample 
bookmarks menu installed. The bookmarks menu right next to the Diamond menu always displays all 
bookmarks in your current open URL Manager Pro bookmarks document. The name of the menu is the name 



of the document, in this case Sample. 

 

If you go to the Sample menu, you will see that it lists all the folders and subfolders in the Sample file. 

If, for example, you select URL Manager Pro's Home Page, from the Tutorial sub menu, your Web browser 
will open this page, provided you are connected to the Internet. Once you get used to using the Shared 
Menus, you will find that it is a powerful feature of URL Manager Pro. The Diamond menu and the Shared 
Menus are explained in this help book, but more specific information is also given Shared Menus Help book. 

Note: If you double click the Contact the Author bookmark, your email program will be started. This is 
because it is a different type of Bookmark. It is a bookmark with the mailto: protocol. This feature of URL 
Manager Pro is described in more detail later. 

Open a Web page using Drag & Drop
Drag & Drop is a powerful feature of the Mac operating system. It allows you to drag icons and other objects 
from one program to another. This is very useful for opening Web pages whose Bookmarks are stored in 
URL Manager Pro. To open a Web page using Drag & Drop, you will need to make both your Web browser 
and the URL Manager Pro windows visible. On a monitor, this shouldn't be difficult; on a PowerBook, you 
may need to have one slightly over- lapping the other. 

Activate the URL Manager Pro bookmark window by clicking on its window title bar. Open a folder by 
double clicking on it or click the disclosure triangle. For example, open the Magazines folder. 

Select, for example, the MacWeek icon. 

Now, press the mouse button and keep it depressed. 

While you are doing this, move the cursor over to the exposed part of your Web browser window. If you look 
carefully, you will see an outline of the icon as you drag it. This is to let you know that Drag & Drop is 
functioning. 

When your mouse cursor is over the Web browser window, release the mouse button. You have now 
"dropped" this icon in your Web browser. Your Web browser will now open the MacWeek home page, 
provided you have an active Internet connection. 

You can explore the other Bookmarks in the Sample document at your leisure, either by opening them from 
within URL Manager Pro or by means of Drag & Drop. We have supplied a collection which we think may 
be of interest to you as a Mac user. However, you will probably want to start developing a collecÐ- tion of 
your own URLs right away. You will learn how to add URLs to URL Manager Pro in the next section. 

Adding Bookmarks to URL Manager Pro

You can add Bookmarks to URL Manager Pro in one of four ways. The first way is by adding Bookmarks 
directly to URL Manager Pro from inside the program. The second way is by means one of the Shared Menus 
it installs in your Web browser. The third way is by means of Drag & Drop. The fourth way is by importing 

help:openbook=Shared%20Menus%20Help


the bookmarks file of your Web browser. These four approaches each have their own advantages and are 
described below. 

Adding Bookmarks directly in URL Manager Pro
If URL Manager Pro isn't already running, open the URL Manager Pro folder and click on the URL Manager 
Pro icon to start the program. 

As before, you will be presented with the default URL Manager Pro document called Sample. 

Let's say you would like creating a Bookmark for AltaVista, a popular site for searching the Web. 

Select the Bookmark "Contact the author". 

Go to the Bookmarks menu. 

Select the command New Bookmark. 

This will create a blank bookmark icon in the Sample document called Untitled. The new bookmark is 
created after the selection. 

 

The label field next to the icon will be highlighted, which is URL Manager Pro's way of prompting you to 
give it a name right away. 

Type in AltaVista. 

Press Tab. 

Now, the URL field will be highlighted. For now, ignore the string of letters http:// in this field. This is part 
of the Internet's URL addressing scheme. It indicates that the address is a Web page. (This is the URL 
Manager Pro default) 

Click the mouse cursor to the right of http:// and start typing: www.altavista.com 

Press Enter when you are done. The new icon is now called "AltaVista". 

Make sure that you typed it correctly and that there are no spaces. If there are any spaces, URL Manager Pro 
will not be able to open the page. 

Now double-click on the new AltaVista icon. Your Web browser will open the AltaVista Web page, provided 
you have an active Internet connection. 



If you are connected to the Internet, your Web browser should load the AltaVista Web site. It may take 
several seconds to load completely. AltaVista is very useful for finding things on the Web. Keep in mind that 
it may take ten seconds or more to display the results of a search. 

You will find this technique for entering a Bookmark directly in URL Manager Pro is useful for adding a 
Bookmark you find listed in a magazine or newspaper or another source away from your computer. For a 
Bookmark you discover when surfing the Internet, there is a better way of adding it to URL Manager Pro. 

At this point, now that you have started customising your collection of Bookmarks, you may want to give it a 
more meaningful name. Let's rename the Sample document. 

Go the File menu. 

Select Save As... You will be prompted to give it another name (the name of the current document, Sample, 
is listed as default). 

Type in a suitable name, such as My Bookmarks 

The follow-up procedure is different on Mac OS 9 and Mac OS X. 

On Mac OS 9, the Save As dialog will look something like this: 

 

Using the folder icon (the middle button on the right in the picture above). Select Documents from that folder 
popup menu to make the Documents directory the current directory. 

Click the New Folder button. Enter the folder name Bookmarks. Now save your new file in this new 
folder. 

On Mac OS X, the Save As dialog will look something like this: 



 

Using the popup menu next right to the Where: label. Select Documents from that popup menu to make the 
Documents directory the current directory. 

Use the downward pointing triangle button to expand the window. 

Click the New Folder button. Enter the folder name Bookmarks. Now save your new file in this new 
folder. 

Sample has now been renamed My Bookmarks and saved in the folder ~/Documents/Bookmarks/ on 
your hard disk. 

Tip (Mac OS X): To have a Bookmark file started up automatically each time you launch URL Manager Pro, 
open Preferences and use the button 'Select Bookmark File...'. 

Note: To have multiple Bookmark file started up automatically each time you launch URL Manager Pro, put 
these files into a folder named Startup Items in the ~/Documents/Bookmarks/ folder. On the 
other hand, you may also want to drag the Sample document out of Startup Items so that it will not be loaded 
at startup. Put it in the Cabinet folder instead. Documents in the Cabinet folder can be easily opened from 
within URL Manager Pro via the Quick Open menu command of the File menu. Furthermore, documents in 
the Cabinet folder are listed in the Cabinet sub menu of the Diamond menu. This means you can open your 
bookmark files right from within your web browser! 

Below you can see the preferred hierarchy of storing your bookmark documents. 

 

Note: You may use aliases for the Startup Items and Cabinet folders and the Bookmarks files may also be 
aliases. The Cabinet and Startup Items folders are more fully explained in the Special Features section of the 
Reference of the User's Guide. 

Adding Bookmarks to URL Manager Pro from within your Web browser



First, switch to your Web browser. 

Let's say you have encountered a Web page and you would like to save its Bookmark in URL Manager Pro. 
The URL is, for example: http://www.washingtonpost.com. (For the purpose of this tutorial, open 
the home page of this well-known newspaper in your Web browser). 

Go to the Diamond menu and select the first command, Add Bookmark.... 

The Add Note Window will be displayed. By default, the title of the Web page is displayed as the name of 
the bookmark, but you can enter any text you wish. In this case, the default is "Washingtonpost.com:News 
Front" Let's rename it simply: "Washington Post". 

In the empty box underneath, the Note field, you can enter a description of this Web page. This is useful for 
keeping pertinent information about this page. Let's add a Note, for example: "Washington DC daily". 

The following dialog box will be displayed: 

 

Tip: You may think that the contents of a Web page is obvious from its name or URL, and that, at the 
moment you save a Bookmark, a Note is unnecessary. However, after using URL Manager Pro for a while, 
most people find they have a very large and continually growing collections of Bookmarks. You may find 
you have a hard time finding a Bookmark you saved in the past or remembering why you saved a Bookmark. 
This is particularly the case for the URL of a document buried deep within a Web site. If you add a one or 
two line note at the time you save a URL, your Bookmarks will be easier to manage, and you will more easily 
be able to find a Bookmark again. 

This Bookmark will now be added to URL Manager Pro. 

Switch to URL Manager Pro. Open the Drop Basket folder. New Bookmarks you add using the Add 
Bookmark command are stored in the Drop Basket folder. You will find an icon called "Washington Post". 



 

To the left of the title, you will see the Bookmark icon. This information was automatically retrieved from 
your Web browser. 

If you added a description to this Bookmark, the Clipboard icon will be displayed directly to the left of the 
URL. This serves a reminder that there is a note attached to the Bookmark. 

To view and edit the Bookmark, go to the Bookmarks menu and select Get Info. The Get Info Window will 
be displayed. It contains a variety of information about the Bookmark, including the Name, URL, and Note 
field, and several advanced options. 

Note: You can modify the Name and Note if you wish, but we recommend you do not change the URL. If so 
much as one letter is modified incorrectly, you will be unable to reopen this Web page. 

For the moment, you can leave your new Bookmarks in the Drop Basket, but in most cases, you will 
eventually want to move items in the Drop Basket to other folders, depending on how you want to sort your 
Bookmarks. In some cases, however, you may already know in which folder you would like to save a 
Bookmark. In the next section, you will learn how to save a Bookmark directly into a specific folder. 

Adding a Bookmark using a Shared Menu
In this section, we will create a new folder and save a Bookmark into it directly. 

First, switch to URL Manager Pro. 

Go the Bookmarks menu and select the command New Folder. 

At the bottom of the Window, a new folder will appear called Empty Folder. Its label will be highlighted, and 
you can give it a more distinctive name. (If you select a bookmark or folder first, the new folder will be 
created just under the selection.) 

Let's call it "Newspapers". 

Now, go to your Web browser and choose Refresh Menus from the Diamond menu. 

If you don't already have an active Internet connection, open one. 

Go to the Washington Post web site: http://www.washingtonpost.com. It is sufficient to only type 
'washingtonpost' in the browser's Location field. 

In the previous exercise, you saved the Bookmark of this site to the Drop Basket using the Add Bookmark 
command in the Diamond menu. But let's say that you would prefer to save this Bookmark into a different 
folder, one you have already created for this kind of site. 

If you look at the menu bar, to the right of the Diamond menu, you will see a menu called Sample or My 
Bookmarks. This bookmarks menu will list all your bookmarks in the current open URL Manager Pro 

http://www.washingtonpost.com/


document. 

Go the Newspapers sub menu. You will see just one command displayed, Add Bookmark.... Select this 
command. 

 

The Add Note Window will be displayed. By default, the title of the Web page is displayed as the name of 
the bookmark, but you can enter any text you wish. In this case, the default is Washingtonpost.com:News 
Front. 

Let's rename it simply to "Washington Post". 

In the empty box underneath, you can enter a description of this Web page. This is useful for keeping 
pertinent information about this page and helping you remember its contents. 

Let's add a note, for example: A Washington DC daily newspaper 

Click the Add button and switch back to URL Manager Pro. 

If you open the Newspapers folder icon by double-clicking it, you will see the Bookmark you just saved 
located here. It will have a Clipboard icon to the right of the Bookmark, reminding you that there is a note 
attached to it. You will find the function of saving a Bookmark to a specific folder extremely useful when you 
are collecting Bookmarks of a similar type, such as the Web sites of newspapers, for example. 

Most of the time, you will find that you save Bookmarks to URL Manager Pro either by means of the Add 
Bookmark command in the Diamond menu or, as in the above example, the Add Bookmark command in a 
Shared Menu that you have defined. However, if you have been surfing the Web for a while, you may have 
built up a substantial collection of Bookmarks in your Web browser. Wouldn't it be nice to move this 
collection into URL Manager Pro? In the next section, you will learn how to do this. 

Importing Bookmarks to URL Manager Pro
URL Manager Pro allows you to import bookmarks created in Microsoft Internet Explorer. 

Note: URL Manager Pro also supports importing from Netscape, Mozilla, OmniWeb and iCab. 

Select your browser from the submenu of Get from Browser from the File menu. 

URL Manager Pro will import your browser's Bookmark file and open it as a separate URL Manager Pro 
document. It will have the same title as the browser Bookmark file. 

You now have two URL Manager Pro document windows open. At this point, you may want to move the 
imported bookmarks into your main document, Sample, or whatever you may have renamed it. 

You can copy Bookmarks one by one, by selection, or all at once. 



To copy one Bookmark from the import file, select its icon with the mouse cursor and drag it to the target 
document, i.e. Sample. 

The icon of this Bookmark will be added to the existing collection. 

To copy a selection of Bookmarks from the import file, proceed as follows. 

Select an icon with the mouse cursor. 

Press the Command key ( ) and hold it down. 

Select as many other icons as you wish. The icons you select will be highlighted. 

Now drag the selection to the target document, i.e. Sample. 

The icons of these Bookmarks will be added to the existing collection. 

Note: to make a selection of multiple Bookmarks you can also use the Shift key or use the Drag-Select way 
of making selections. 

To copy all the Bookmarks from the import file: 

Go the Edit menu and select the command Select All. 

Now drag the selection to the target document, i.e. Sample. 

All of the icons in the import file will be added to the existing collection 

You now are familiar with the basic techniques of adding Bookmarks to URL Manager Pro and opening 
Bookmarks saved in URL Manager Pro. In the next section, we will start to explore some of URL Manager 
Pro's sophisticated features for organizing your Bookmarks. This is where you will discover some of the 
important advantages of storing your Bookmarks in URL Manager Pro, rather than Bookmarks feature of 
your Web browser. 

Organizing your Bookmarks

In this section, you are going to acquire some basic skills in organizing Bookmarks. You will learn how to 
create, copy, and delete Bookmarks. You will also learn how to search for a Bookmark. 

In the previous examples, you learned how to create a blank Bookmark using the New Bookmark command 
in the Bookmarks menu. You also learned how to create a new folder using New Folder command of the 
Bookmarks menu, and how to add Bookmarks to it. Now you will create a folder within a folder, called a 
subfolder, and copy a Bookmark to it. 

Let's use the example we used above. Open the Newspapers folder. It will contain the Bookmark for the 
Washington Post Web site. 



Select the Washington Post icon. It will now be highlighted. 

Go to the Bookmarks menu and select New Folder. 

A new folder will now be created. By default, its name is Empty Folder. The title field is highlighted and you 
can give it a more meaningful name. Let's call it: Washington DC Newspapers. Press the Enter key to save 
this name. 

Now select the Washington Post icon and press the mouse button. Keeping the mouse button depressed, drag 
this icon on top of the Washington DC Newspapers folder icon. 

Now double click Washington DC Newspapers folder to open it. The Washington Post icon will be in this 
folder. Double-click the folder again to close it. 

By using subfolders, you can make it much easier to manage large collections of Bookmarks. Say, for 
example, you are developing a large collection of Bookmarks of newspapers. By arranging them in 
subfolders, such as by city, state/province, and/or country, you will find it much easier to manage your 
collection as it grows. 

In the above example, you moved a Bookmark from one folder to another. Sometimes, you will want to 
create a duplicate copy of a Bookmark. You can do this in several ways. 

Say, for example, you would like a duplicate copy of a Bookmark in the same folder. 

Let's try this by going to the Tutorial folder. 

Open it by double-clicking it. 

Select the URL Manager Pro's Home Page icon. It will be highlighted. 

Press down the Option key and start dragging the icon. 

Move the icon below the email icon of the last Bookmark in the folder and release. A copy of the Bookmark 
will appear. 

Please note the underline that the program draws (see below) as you move the icon over bookmarks. It tells 
you where the bookmark will be dropped. 

 

In most cases, you won't find it useful to have two identical Bookmarks in the same folder. But maybe you 
would like to have the same Bookmark in another folder as well. 

For example, you might want to have a link to the URL Manager Pro Web site in your Macintosh Links 



folder. In this case, click on the icon of the duplicate Bookmark, hold down the mouse button, and Drag & 
Drop it to that folder. You now have the same Bookmark in two locations. 

While you will find it slightly easier to manage your Bookmarks if you keep only a single copy of each 
Bookmark, you may nonetheless find it useful to have copies in some cases. For example, you may find you 
want to keep a copy of the Bookmark for the Netscape Web site in both your Mac applications and Internet 
folders. Or you may want to keep Yahoo in both your News and Search folders. 

You can also delete Bookmarks you don't need any more. Let's delete the duplicate Bookmark we just 
created. 

Open the Macintosh Links folder. 

Select the URL Manager Pro icon. 

Press the Backspace key. This Bookmark will be deleted. 

Tip: to delete multiple Bookmarks, select them and then press the Backspace key. 

There are times when you will want to find a Bookmark quickly without opening folders. To do this, you can 
use URL Manager Pro's Find function. 

Go the Edit menu and select Find. 

The Find dialog box will be displayed. You can enter a text to search for in the Find field, which is 
highlighted. 

For example, enter: Dilbert 

Press the Find button. 

The Find function found a Bookmark, which contains the text "Dilbert" in the Magazines folder. Press the 
Cancel button to close the Find dialog box. This Bookmark is highlighted. 

If you would like to continue the search, select the Find Again command from the Edit menu. The Find 
function will search for another Bookmark with the same text. 

In this case, URL Manager Pro will beep because this is the only Bookmark containing the text "Dilbert". 

Close the Magazines folder. 

The URL Manager Pro Find function also searches the Notes attached to Bookmarks. 

For example, select Find and enter: daily 

URL Manager Pro will find this text in the Washington Post Bookmark you entered earlier. It will display the 
Get Info dialog box so that you can view the Note field containing this text. 



Press Enter to close the Get Info Window. 

Tip: As you can see, by adding meaningful information to the Note field of Bookmarks, you make it easier to 
find Bookmarks again. This becomes useful when you have a large collection of Bookmarks. 

While the majority of Bookmarks you collect in URL Manager Pro will be Bookmarks of Web pages, URL 
Manager Pro also allows you to store Bookmarks for other kinds of Internet addresses. In the next and final 
part of this tutorial, you will learn how URL Manager Pro handles email addresses. 

Using URL Manager Pro with your email program
URL Manager Pro interacts with your email program in similar way as it interacts with your Web browser. 
For URL Manager Pro, an email address is, in fact, just one of several types of Bookmarks which it 
recognises. The chief difference between an email address Bookmark and a Web page Bookmark is that when 
you give URL Manager Pro the command to open an email address, it passes this command to your email 
program, not to your Web browser. 

For example, open the Tutorial folder. 

Inside you will see an icon called "Contact the Author". It has a different icon than the URL Manager Pro 
Home Page icon. This is because it is an email address Bookmark. 

Double-click on this icon. It will launch your email program if it is not running. If it is running, it will open a 
New Message window with this address in the To: field. 

Note: By default, URL Manager Pro is configured to recognise Eudora as your email program. If you want to 
change that configuration, open Preferences and click the Internet tab. 

As in the case of your Web browser, URL Manager Pro also adds its Diamond menu to your email program. 
This means you can also save email address Bookmarks to URL Manager Pro from within your email 
program. 

Note: Currently Eudora on Mac OS X does not support the Diamond menu yet. Enrourage on X will show the 
Diamond menu on the first update after version 1.0. 

Note: If you want to have the Diamond menu in applications other than web browsers, you must make sure 
that the preference 'Show Shared Menus only in Web Browsers' in Preferences from the Diamond menu is 
turned off. 

For example, open a Message Window in your email program. 

Select the text containing the email address (see below for an example). 

Choose the Add Bookmark... command from your email program's Diamond menu. 



 

Tip: Alternatively, you can use the Diamond menu's Grab All command to extract all email addresses from a 
message. Although you can easily store your Web page Bookmarks and your email addresses in the 
respective Bookmarks and Address Books of your browser and your email program, you may find it 
ultimately more convenient and secure to store all your Bookmarks, Email addresses, and the like-in one 
central location: URL Manager Pro. This makes it easier to move from one browser or email program to 
another, even from one computer to another. Furthermore, URL Manager Pro is especially adept at helping 
you manage large collections of Bookmarks. 

Launching URL Manager Pro automatically

You can configure URL Manager Pro in such a way so that it automatically opens when you launch your 
browser. Choose the Preferences command from the Diamond menu. Click the At Startup tab. Enable the 
'Launch URL Manager Pro at startup' checkbox and use the Select... button to specify which version of the 
URL Manager Pro application you actually want to be launched. 

This concludes the Getting Started with URL Manager Pro tutorial. By now, you have gotten acquainted with 
the main features of URL Manager Pro. You can explore the program further on your own or use the 
Reference section to learn more about additional specific features. 



Uniform Resource Locators (URLs) 
Explained
This section provides additional information about what URLs are and how URL Manager Pro 
handles them. 

Syntax of URLs
A Uniform Resource Locator (URL) is the format in which an Internet address is stored. 

It takes the format: 

     <protocol> <username> <password> <hostname><port> <path> 
<document> 

For example, the URL of this document could be: 

     http://www.url-manager.com/doc/manual.pdf where 

     http:// is the protocol indicating the URL is the address of a Web page, 

     www.url-manager.com is the name of the host computer, 

     /doc/ is the path (also called a subdirectory) on that computer, and 

     manual.pdf is the name of the document. 

The URL of a password-protected page looks like this: 

     http://myfriends:secret@www.address.edu/index.html 

Note: username, password, path and document are optional elements of a URL; some URLs only 
consist of prefix and hostname. Others are just a path and document. A document can also be a 
program, such as a Perl script. 

URLs were originally intended for internal use by Internet programs, not to be seen by end-users. As a 
result, they are not particularly "user-friendly." They can be long and arcane looking. 

URL Manager Pro and URLs
URL Manager Pro does it best to shield you from complexity of URLs by representing them by icons 
and allowing you to give them a descriptive label. It allows you access and manipulate URLs by 
convenient techniques, such as pull-down menus and as Drag & Drop. We recommend that you do not 
edit URLs manually. If you make an error in a URL, it will no longer work. Errors in URLs are 



difficult to fix, and it may take you considerable effort to relocate the Web page or E-mail address 
whose URL you lost. 

However, if you are an experienced user, you will find that URL Manager Pro enables you to view 
and edit URLs very easily. 

Types of URLs
By far, the most frequent URLs you will save in URL Manager Pro will be Web pages. However, 
URL Manager Pro also recognises other types of URLs. These are: Web addresses, E-mail addresses, 
FTP hosts, Newsgroup addresses, Telnet hosts, Finger hosts, Gopher addresses, Wais hosts, Query 
URLs 

 

Based on its protocol, each type of URL in URL Manager Pro has been assigned a default Internet 
application. This application is opened when you select a URL of this type. 

To know which assignments to use, URL Manager Pro uses the information stored on the Internet tab 
of its Preferences Window. You can view and modify your Web browser and E-mail program 
assignments by selecting the Preferences command of the Edit menu or by clicking the Pref button in 
the Toolbar of URL Manager Pro. Then go to the Internet tab of its Preferences Window. 

You can modify other assignments in Internet Config by selecting Launch Internet Config on the 
Preferences submenu of the Edit menu in URL Manager Pro. However, on Mac OS 8.5, you use the 
Internet Control Panel. 

Open the Internet Control Panel. 

Select the User Mode command from the Edit menu. 

Click the Advanced tab. 

Click the icon Helper Apps in the left icon scroll box. 

Modify your assignment in the Helper Application Assignments box. 

Bookmarks and URLs in URL Manager Pro 
URL Manager Pro uses the concept "Bookmark" in its handling of URLs. In URL Manager Pro, a 
Bookmark is comprised of a URL, a user-defined Name, an optional Note, and several attributes. This 
information can be viewed and modified in the Get Info Window. 



Shared Menus

Introduction

What is the Shared Menu?

The Shared Menu is a custom menu installed by either URL Manager Pro or Web Confidential in the 
menu of your web browser or other Internet applications. The Shared Menu gives you access to all 
your bookmarks stored in URL Manager Pro, the bookmark and URL manager, or your passwords in 
Web Confidential, the password organizer and encryption tool, provided you have previously installed 
either or both programs. 

By default, the Shared Menu icon is displayed as a diamond symbol:    

In Web Confidential mode (see below), it is displayed as a card symbol:    

By default, all bookmarks in your current open URL Manager Pro document will be shown as extra 
bookmark menus in your web browser's menu bar. Optionally, your bookmark menus will also be 
shown in other Internet applications, like Eudora and Interarchy. 

Your passwords can be accessed from the Confidential submenu of the Shared Menu. 

Note: On Mac OS X, you can also access to your bookmarks and passwords from Dock popup menus. 

Features

With Shared Menus you can: 

●     have access to your bookmarks from within any browser 
●     store your bookmarks independently from your browser 
●     store your bookmarks in self-contained documents 
●     have more bookmark menus in your menu bar 
●     add notes to your bookmarks as you add them 
●     have access to your confidential information from within any browser 

Installation on Mac OS 9 and Mac OS X

Shared Menus are provided by the so-called Shared Menus Component.

When either URL Manager Pro or Web Confidential is first run, the Shared Menus Component, with 
your permission, will automatically be installed. However, circumstances may arise when you need to 

http://www.url-manager.com/
http://www.web-confidential.com/
file:///HD/Documents/Shared%20Menus%20Help/dock.html


install it manually. In that case, you need to perform the following steps: 

●     Download the Shared Menus Component. The URL is:
<ftp://ftp.url-manager.com/pub/SharedMenus.component.bin> 

●     Put it in the right location (see below). 

Its file name is 'SharedMenus.component'. Its location on your Mac is: 

On Mac OS 9: 

●     System Folder:Extensions: 

On Mac OS X: 

●     ~/Library/Components/ 

The ~ character signifies your home directory. 

If you wish, you may also move the component to the folder: 

●     /Library/Components/ 

Do not install the component in both places; one will suffice. 

To deinstall, just remove the component from the 'Extensions' or 'Components' folder and move it to 
another location. You can also choose the Preferences command from the Diamond Shared Menu and 
press the Deinstall button. 

Commands

This lists all commands from the URL Manager Pro or Web Confidential Shared Menu. 

●     Add Bookmark - lets you bookmark the current web page.
In Web Confidential mode (see Preferences below) this commands reads Add Card. 

●     Help - opens the Apple Help Viewer and the Shared Menus Helpbook 
●     Grab All - grabs all links of the current web page. 
●     Explore - lists all your Explore favorites.

Use the Edit Favorites command from the Edit menu in URL Manager Pro to create and edit 
these bookmarks. 

●     Favorites - lists all your Favorite favorites.
Use the Edit Favorites command from the Edit menu in URL Manager Pro to create and edit 
these bookmarks. 

●     Confidential - lists all your confidential information.
This menu lists all password categories and its contents of your open password file. 

ftp://ftp.url-manager.com/pub/SharedMenus.component.bin
ftp://ftp.url-manager.com/pub/SharedMenus.component.bin


●     Cabinet - lists all your preferred bookmark and password documents. 

For your bookmark documents, please create a folder named 'Bookmarks' in your 'Documents' 
folder and put your 'Startup Items' and 'Cabinet' folders in your 'Bookmarks' folder of your 
'Documents' folder. Idem dito for your password documents: please create a folder named 
'Passwords' in your 'Documents' folder.

In other words, the paths of these folders are: 

On Mac OS 9: 

❍     Hard disk:Documents:Bookmarks:Cabinet: 
❍     Hard disk:Documents:Bookmarks:Startup Items: 
❍     Hard disk:Documents:Passwords:Cabinet: 
❍     Hard disk:Documents:Passwords:Startup Items: 

On Mac OS X: 

❍     ~/Documents/Bookmarks/Cabinet/ 
❍     ~/Documents/Bookmarks/Startup Items/ 
❍     ~/Documents/Passwords/Cabinet/ 
❍     ~/Documents/Passwords/Startup Items/ 

●     Mac News - the Read All command opens several Mac News sites concurrently in multiple 
browser windows. Using the checkmarks in the menu items of the submenu, you determine 
which ones you want to read. Hold down the Command key while making a menu choice to 
open that Mac News site only. 

●     Read Daily - opens all your Daily favorites concurrently in multiple browser windows.
Use the Edit Favorites command from the Edit menu in URL Manager Pro to create and edit 
these bookmarks. 

●     Go to Home Page - opens your home page 
●     Go to Search Engine - open your preferred Search Engine page

These preferences are defined in URL Manager Pro's Preferences Personal tab. 
●     URL Manager Pro - launches or switches to URL Manager Pro. 
●     Web Confidential - launches or switches to Web Confidential. 
●     HTML Editor - launches or switches to BBEdit. 
●     Email - launches or switches to your Email application. 
●     WWW - launches or switches to your Web browser. 
●     Refresh Menus - use this command to update your shared bookmark menus with the latest 

changes in your bookmark document. 
●     Preferences - shows the Preferences window. 
●     Quit - quits your current Internet application and URL Manager Pro with one command. 
●     Customer Support - email the author. 
●     How to Register - brief instructions on how to register. 
●     Register Online! - go to to Kagi Online. 



Preferences

This lists all preferences: 

In the 'General' tab: 

●     Add notes when adding bookmarks - lets you add a note while you add a bookmark. 
●     Always open a bookmark in a new window - when choosing a bookmark from a shared 

menu, it opens in a new browser window. 
●     Use Sherlock instead of Search Engine - use the Sherlock search function of the Mac OS. 
●     Show Shared Menus only in Web Browsers - Shared Menus are only shown in Web 

Browsers and not in other applications. 
●     Don't load WWW Forms - This is Web Confidential preference is useful when you are 

normally already on the Web Page with the WWW Form and only need to see your user ID 
and password in the Card Info Window, but do not want to load the Web Page. 

In the 'At Startup' tab: 

●     Launch URL Manager Pro at startup - automatically launch URL Manager Pro at startup of 
Internet applications. 

●     Launch Web Confidential at startup - automatically launch Web Confidential at startup of 
Internet applications. 

Note: you need to use the Select button to specify which copy of the application on your hard disk 
you actually want launched. 

In the 'Appearance' tab: 

●     Use a small menu font - use a small font in the shared menus. 
●     Do not put icons in menus - do not put icons in the shared menus. 
●     Disable all keyboard shortcuts - disable all keyboard shortcuts of the shared menus. 
●     Use  U as URL Manager Pro shortcut - enable this keyboard shortcut in your applications. 
●     Go into Web Confidential mode - show the password icon as the menu title icon. The 

command Add Card will add the current web page to the WWW Sites category. 
●     Use Document Icon instead of document title - conserve space in menu bar with icon instead 

of text. 

Default Bookmarks

For your bookmark documents to automatically open at launch time of URL Manager Pro, create a 
folder named 'Bookmarks' in your 'Documents' folder and within that folder create a folder named 
'Startup Items'. Put your default or startup bookmark document in that folder.



In other words, the path is: 

On Mac OS 9: 

●     Hard disk:Documents:Bookmarks:Startup Items: 

On Mac OS X: 

●     ~/Documents/Bookmarks/Startup Items/ 

Also make sure that the URL Manager Pro preference 'Open Startup Items' is checked.

To launch URL Manager Pro automatically at launch time of your web browser see the section 
Preferences/At Startup in the previous paragraph.

Default Passwords

For your password documents to automatically open at launch time of Web Confidential, create a 
folder named 'Passwords' in your 'Documents' folder and within that folder create a folder named 
'Startup Items'. Put your default or startup password document in that folder.

In other words, the path is: 

On Mac OS 9: 

●     Hard disk:Documents:Passwords:Startup Items: 

On Mac OS X: 

●     ~/Documents/Passwords/Startup Items/ 

Also make sure that the Web Confidential preference 'Open Startup Items' is checked.

To launch Web Confidential automatically at launch time of your web browser see the section 
Preferences/At Startup in the previous paragraph.

Modifier Keys

When you hold down the Control (ctrl) key while choosing Add Bookmark from the Diamond menu, 
it toggles the behaviour of your Add Notes preference for that instance of the command. 

When you hold down the Option (option) key while choosing Add Bookmark from the Diamond 
menu, a new card with the name and URL of the current web page will be added to Web Confidential 



instead. 

When you hold down the Command (Apple) key while choosing a bookmark menu item, the URL of 
the bookmark will be copied to the Clipboard. 

When you hold down the Command (Apple) key while choosing a password menu item, a utility 
window showing the card information will be shown. 

When you hold down the Option (option) key while choosing a bookmark menu item, the URL of the 
bookmark will opened in a new browser window. 

When you hold down the Option (option) key while clicking the Internet icon of the utility window, 
the URL of the card will opened in a new browser window. 

When you hold down the Command (Apple) key while choosing a menu item of the Mac News 
submenu, you will load that news page instead. 

Compatibility

Almost any Mac OS 8 or 9 Internet application supports the Shared Menus protocol. On Mac OS X, 
currently, Internet Explorer, Opera, iCab, BBEdit, NetFinder, Interarchy, Fetch and IP Monitor show 
Shared Menus. Please email the developers of Eudora and others to support the Shared Menus 
Protocol on Mac OS X. Thanks! 

How to Print

Explorer is very good in printing HTML pages, so please go to this web page to print this help file. 

How to Purchase

To order URL Manager Pro or Web Confidential, go here: 

Kagi Online Order Page  or   Use PayPal 

To order upgrades, go here: 

eSellerate  or   Use PayPal 

Version 1.1.2.

http://www.url-manager.com/sharedmenushelp/sharedmenus.html
http://order.kagi.com/?AB&S
http://www.url-manager.com/paypal.html
http://store.esellerate.net/s.asp?s=STR676348566
http://www.url-manager.com/paypal.html


Drag & Drop
URL Manager Pro makes extensive use of Drag & Drop, both within the program and also for 
interactions between URL Manager Pro and your Internet applications and the Finder. We 
differentiate Drag & Drop of Bookmarks, Hypertext Links and Files. 

Bookmarks
Obvious Drag & Drop operations within URL Manager Pro include: 

●     Dragging & Dropping a Bookmark in a folder.
●     Moving a Bookmark or a folder from one location in a Bookmark file hierarchy to another. An 

underline is drawn which indicates where the bookmark will be dropped (see below).
●     Dragging & Dropping a Bookmark to the Favorites Window. 

 

Note: Dragging & Dropping a Bookmark between windows always makes a copy of the Bookmark. 

Tip: To create a duplicate of a Bookmark within a window use Option-Drag. Obvious Drag & Drop 
operations between URL Manager Pro and an external program include: 

●     Dragging & Dropping a Bookmark to the Finder Desktop creates an Internet Location File (see 
below). An Internet Location File is a new feature of Mac OS 8.5 and higher. You can double 
click these files in the Finder and then the Finder will open the URL in the appropriate Internet 
application.

 
●     Dragging & Dropping a Bookmark to the Finder Desktop on pre-Mac OS 8.5 creates a special 

file called a URL File (see below). This file is recognised by Navigator and only contains the 
URL, no additional information. Double-click this file to go to that URL. You can also Drag & 
Drop this file to a Navigator or URL Manager window.



 
●     Dragging & Dropping a Bookmark on Web browser window to open that Bookmark (see 

above).
●     Dragging & Dropping a Bookmark on the icon of your Web browser in the Helper Dock to 

open that Bookmark.

 
●     Dragging & Dropping a Browser Bookmark on the icon of URL Manager Pro in the Helper 

Dock (see below). Bookmark will be placed in your Drop Basket.
●     Dragging & Dropping a Browser Bookmark directly to a Bookmark folder in URL Manager 

Pro.
●     Drag & Drop a Bookmark to a Text Editor to insert a URL at the cursor.
●     Option-Drag & Drop a Bookmark to a Text Editor to insert a URL in HTML format., like this:

 

As can be seen from the above examples, Drag & Drop behaves slightly differently depending on the 
context. 

When you Drag & Drop an object inside a given area of URL Manager Pro, such as the Bookmark file 
window, the action moves the object. 

When you Drag & Drop an object between separate components of URL Manager Pro or between 
URL Manager Pro and an external program, such as a Web browser, the action only copies the object. 
A copy of the object remains in its original location. 

Note: Technically speaking, when you Drag & Drop a Bookmark from URL Manager Pro onto an 
external program icon or a program window, you are in fact just passing the information contained in 
a Bookmark temporarily to the program. A copy of the Bookmark does not appear or remain in the 
program. 

Additional uses



In addition to the obvious uses of Drag & Drop, there are some less than obvious ones. 

●     You can turn a folder into a Shared Menu by Dragging & Dropping it onto the Web browser 
icon in the Helper Dock.

●     You can Drag & Drop a Bookmark to not only the TO: field of a new message but also the CC: 
or BCC: fields. Drag & Drop copies both the Name (the recipient's name) and the URL (the 
recipient's email address) to these fields.

●     You can Drag & Drop a folder of email Address Bookmarks to the email icon in the Helper 
Dock to create a message addressed to a list of users.

●     You can Drag & Drop a folder of email address Bookmarks to the Address Book of Claris 
Emailer. A new Address Group will be created containing these users (username and E- mail 
address).

Tip: To send Bulk Mail, Drag & Drop a folder of email address Bookmarks to the email icon in the 
Helper Dock. The email addresses will be inserted in the Bcc: field. The complete list of names and 
addresses will not be displayed in the recipients' message headers. The To: field is set to your personal 
email address. Your personal email address must be set via Internet Config or the Internet Control 
Panel. 

Tip: To send Bulk Mail in Claris Emailer, Drag & Drop a folder of email address Bookmarks to the 
Bcc: field of a new message. The email addresses will be inserted in this field. The complete list of 
names and addresses will not be displayed in the recipients' message headers. 

Note: When you Drag & Drop a folder of email address bookmarks, it must be closed and all non-
email address Bookmarks will be ignored. 

Text
When you Drag & Drop a text selection from a word processor or the Notepad to a Bookmark file, 
URL Manager Pro will scan the dropped text for URLs and create bookmarks for them. 

Hypertext links
You can Drag & Drop hypertext links that appear in a Web browser window to a Bookmark file. URL 
Manager creates a bookmark using the name and URL of the hypertext link. You determine by Drag 
& Drop where the new bookmark will be placed in the hierarchy. You can also Drag & Drop 
hypertext links to the URL Manager Pro icon in the Helper Dock. In this case, the bookmark is put in 
the Drop Basket. 

Note: In Cyberdog, please use Option-Drag when using Drag & Drop of hypertext links. 

Files
You can Drag & Drop TEXT files, HTML files, URL Files, Internet Location Files (Mac OS 8.5 or 
higher), AOL Favorites, Anarchie or Interarchy Bookmarks, and Fetch Bookmarks to a URL Manager 
Pro Bookmark window. URL Manager Pro will then import all URLs and bookmarks that are in these 
files and put them in a new Bookmark folder. 



You can also Drag & Drop these files to the URL Manager Pro icon in the Helper Dock. URL 
Manager Pro will create a new Bookmark file and then import all URLs and bookmarks from the 
dropped file. 

Note: To import AOL Favorites, first drag an AOL Favorite to the Finder Desktop. Then drag this 
new file to your Bookmark window. 

Tip: Some file icons you can Drag & Drop to a Bookmark window are shown below. 

 



Preferences
URL Manager Pro offers you an "out-of-box" experience, virtually speaking: you can download the 
software, run the install program, and get right to work with it. For many users, URL Manager Pro's 
default configuration works just fine. 

However, if you want, you can easily configure URL Manager Pro to suit your specific needs. By 
means of the Preferences window, you can modify the way URL Manager Pro looks, the way it works, 
and they way it interacts with other applications, both on your own computer and on remote systems. 

There are two ways to access the Preferences Window in URL Manager Pro: 

●     By clicking the Pref button in the Toolbar,
●     By selecting the Preferences command in the Edit menu.

Either way, the Preferences Window will be displayed. 

Note: Under Mac OS X, the Preferences command is in the URL Manager Pro menu instead. 

The Preferences Window contains seven tabs. They are General, Personal, Internet, URLs, Look & 
Feel, Shared Menus and Miscellaneous. Each of the options on these windows is explained below. 

General

At Startup

Open "Startup Items" 
Documents in this folder are automatically opened when the program is launched. You can disable this 
by switching this option off. Default: on 

The location of the folder "Startup Items" is very important. It must be either in the same folder as 
URL Manager Pro (on Mac OS 9) or it must be in the folder "Bookmarks" in your "Documents" folder 
(Mac OS 9 and Mac OS X). 

Below you can see the preferred hierarchy of storing your bookmark documents. 

 



Note: If you do not want to organize your bookmark files in this way and need only one startup 
bookmark file, see the preference 'Select Bookmark File...' below. 

Launch Web Browser
To automatically launch your Web browser when you launch URL Manager Pro, enable this option. 
Default: off 

Use 'Local' Preferences (Mac OS 9 only)
URL Manager Pro, like most Mac applications, normally stores its Preferences file in the Preferences 
folder found in the System Folder. To override this and have URL Manager Pro save its Preferences in 
its own folder (the URL Manager Pro folder), enable this option. (It will also write the URL Manager 
Favorites file to the URL Manager Pro folder.) When URL Manager Pro is launched, it will 
automatically use the Preferences stored in its own folder. Default: off 

Tip: This feature is useful for carrying your URL Manager Pro Bookmark file from one computer to 
another on a ZIP or floppy disk. 

Open 'Untitled' Window
When URL Manager Pro in in the background and does not have any bookmark documents open, and 
you want to bring it into the foregroud by clicking the hollow icon in the Finder or clicking on the 
URL Manager Pro icon on the Mac OS X Dock, enable this option when you want an 'Untitled' 
Window opened. Default: off 

Select Bookmark File...
Available on Mac OS X only, this feature lets you select a bookmark file to startup with. 

History

Enable history
URL Manager Pro keeps a history file of the Web pages you have visited. This is useful for retracing 
your steps when you are surfing the Web. However, for reasons of confidentiality, you may want to 
switch this option off. The history file is written to your Preferences folder and its name is URL 
Manager History. Default: on 

100/1000 Web pages
Using this option you can configure URL Manager Pro to save in its history either the last 100 or the 
last 1000 pages you have visited. 

Saving Documents

Save Every [ ] minutes
To have URL Manager Pro save changes to open documents automatically, check this preference. You 
can also specify the number of minutes between every Save. Default: off 



Automatically Save On Close
If you have made changes to a Bookmark file, URL Manager Pro will prompt you to save these 
changes when you exit the program. Enable this option to save changes without confirmation. Default: 
off 

Always Create Backup Copy
When you save a Bookmark file, the previous version is renamed with the extension .bkup. To disable 
this function, switch this option off. Default: on 

Remember Position and Size
To have URL Manager Pro remember the layout of your windows when you close documents, switch 
this option on. Window positions and the status of folders (open/closed) will be saved. Default: on 

Backups of Documents

Copy Bookmark File On Save
URL Manager Pro can make a backup of your Bookmark file to another volume or partition on each 
save. Preferably, you use it to have a backup copy on another partition or hard disk. Default: off 

Copy History File On Save
URL Manager Pro can make a backup of your History file to another volume or partition on each save. 
Preferably, you use it to have a backup copy on another partition or hard disk. Default: off 

Select Folder
Use the Select Folder button to specify the destination folder of the backup copies. 

Personal

WWW Pages

Home Page
If you click on the Home button in the Toolbar, URL Manager Pro will load your Home page, if it has 
been defined in this field. Enter a valid URL here. It can be a local (a file on your hard disk) or a 
remote (an Internet address) page. To fill this field automatically, use the Grab button. The Grab 
button selects the currently active Web page and enters its URL as your Home page. 

Search Engine
If you select Search Engine from the Diamond menu, URL Manager Pro will open the search engine 
you have configured using this option. Enter the URL of a Web search engine here. To fill this field 
automatically, use the Grab button. 

The Grab button selects the currently active Web page and enters its URL as your Search Engine 



Enable User Profiles
Netscape Navigator 4 introduced the concept of User Profiles. If your Netscape Bookmarks are stored 
in your User Profile, enable this option and enter your User Profile name. This option is used when 
importing Bookmarks from your browser with the Get From Browser command. Default: off 

Locate Manually
To supply the location of the folder associated with your User Profile manually, enable the option 
Locate Manually and identify the folder using the folder selector dialog. Default: off 

Internet

When you click on a URL in URL Manager Pro, URL Manager Pro will open it in the appropriate 
application, based on its type (this is identified by the protocol component of the URL). To configure 
URL Manager Pro to recognise the Internet applications you use, enter their applications in the 
following fields. 

WWW & Email Helpers

Browser
Choose your Web browser from the popup menu. 

Email
Choose your Email program from the popup menu. 

Launching Helpers

Search by Name 

URL Manager Pro normally references applications by creator type. However, if you are using 
multiple versions of the same application, such as for example, Navigator 4.0 and Navigator 4.7, this 
can lead to conflicts. Switch this option on to have applications identified by name rather than creator 
type. Default: off 

Include Servers 

URL Manager Pro will search file servers for helper applications. Default: off 

Other Helpers

When using Mac OS 8.5 and later, clicking any of the Other Helper buttons opens the Internet Control 
Panel to the Helper Apps panel, where you can change the Helper used. On pre-Mac OS 8.5 systems, 
Internet Config is opened. You do not have to specify a program for each protocol. On Mac OS X 
clicking the buttons lets you specify an application. For more information see URLs Explained. 



FTP Client - Specify your FTP Client by clicking this button. 

NewsReader - Specify your NewsReader by clicking this button. 

Telnet - Specify your Telnet program by clicking this button. 

Finger -Specify your Finger program by clicking this button. 

Preferred Info-Mac Server

The Preferred Info-Mac Server box displays the name of the Info-Mac server currently defined using 
the Internet Control Panel. 

Preferred Info-Mac Servers are a series of mirrored FTP sites, which serve as important file archives 
for the Mac community. Normally you select the Preferred Info-Mac Server closest to you 
geographically. 

Note: The Preferred Info-Mac Server setting is used simply as an abbreviation for the full URL of the 
site you use. This means that URLs of Bookmarks that point to files on Info-Mac Servers may start 
with /info-mac/. URL Manager Pro will prepend the hostname based on your preferred Info-Mac 
Server. 

Internet Config Application (Mac OS 9 only)
To configure your Internet preferences for all your Internet applications, you use the Internet Control 
Panel in the Apple menu. If you are using a version of the Mac OS prior to version 8.5, you set your 
Internet preferences using the program Internet Config. 

Launch Internet Config (for users of Mac OS versions prior to version 8.5)
To start Internet Config, click on this button. If it is not yet installed on your computer, you will have 
to download it first. 

Download Internet Config
If you have not installed Internet Config on your computer, press this button to download it. 

URLs

URLs
Double Click URL Icon 

Open in Helpers
When you click on a Bookmark icon, URL Manager Pro will open the URL of the Bookmark in the 
appropriate Internet application, based on the information stored in Internet Config program or Internet 
Control Panel. You can override this and force URL Manager Pro to open all URLs in the Browser 



using the Always Open in Browser option below. Default: on 

Always Open in Browser
When you click on a Bookmark icon, URL Manager Pro will always open the URL of the Bookmark 
in your Web browser. 

In a New Browser Window
When you click on a Bookmark icon of a WWW address, URL Manager Pro will open the URL in the 
currently active window of your Web browser. To force URL Manager Pro to open it in a new 
window, enable this option. Default: off 

Modify Web Browser

Use Helpers and Restore
When you select an E-mail, an FTP, or another non-HTTP URL on a Web page in your Web browser, 
your browser should check your Internet Preferences to determine which Helper application to use. 

Older versions of Web browsers may not perform this check properly. Instead of starting up your E-
mail program when you click on a mailto: URL, an older Web browser may start up its own internal E-
mail program. To override this behaviour and force your Web browser to use your Helper applications, 
click the Use Helpers button. To deactivate this command, click the Restore button. 

Copy to Clipboard
Using the Copy command, you can copy a URL to the Clipboard. These option choices allow you to 
modify the information that is copied and what format it is in. 

●     In HTML format
●     Name + URL 
●     URL [default]
●     <url>

The first option, HTML format, Bookmark name, is useful if you are creating Web pages and want to 
enter a Bookmark as a link. The other options are mainly used when you want to use a Bookmark in a 
text document or an E-mail message. 

Note: Dragging always puts the URL in the drag. Using Option-Drag always puts the URL in HTML 
format in the drag. 

Look & Feel

Window Header

Hide Toolbar
URL Manager Pro displays a number of commonly used commands as a Toolbar at the top of its 
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document window. You can hide the toolbar by enabling this option. You will need to quit and 
relaunch URL Manager Pro for this command to take effect. Default: off 

Tip: On Mac OS X, however, just click the Toolbar icon in the top right of the title bar of a bookmark 
window to toggle this preference. See below for a screenshot of the Mac OS X Toolbar icon. 

 

Rotate World Icon
If you have turned Hide Toolbar on, URL Manager Pro will display a small- animated globe on the 
Bookmark Status line. Click on this to launch your Web browser. To turn off the animation, switch 
Rotate off. Default: on 

Show Home Page Icon
If you have turned Hide Toolbar on, URL Manager Pro will display a small Home Page on the 
Bookmark Status line. Click on this to launch your Home Page in your Web browser. Default: on 

Show Search Engine Icon
If you have turned Hide Toolbar on, URL Manager Pro will display a small Search Engine icon on the 
Bookmark Status line. Click on this to launch your Search Engine in your Web browser. Default: on 

Look & Feel

Mac OS 8 and X Type Folders

To use the Mac OS 8 style, slanted folder icons enable this option. Default: off 

Note: On Mac OS 8 or higher, the default is: on 

Use Menu Colors
To display some menu items in the colour green, switch this option on. Not supported on Mac OS X. 
Default: on 

Automatically Sort Folders
If the Automatically Sort Folders option is enabled, folders will retain their sort orders, and will be 
automatically sorted correctly each time their contents are changed. Default: off 

Sort After Grab All
If the Sort after Grab All option is enabled, the new Bookmark window which is displayed after a 
Grab All command will be sorted according to the sort order of the previously active Bookmark 
window. Default: off 



Hide Windows in Background
To hide all of URL Manager Pro's windows when it is in the background, enable this option. This is 
useful for laptop users with a limited amount of screen space. Default: off 

Helper Dock
You can use the Helper Dock as a launching pad for all you favorite Internet applications. For more 
information about the Helper Dock, see Helper Dock in Windows. 

To show the Helper Dock, choose Helper Dock (  H) from the Window menu. To display the Helper 
Dock without labels, click the Zoom box. 

Place Vertical
The Helper Dock displays a horizontal toolbar of Internet applications. By enabling this option, the 
Helper Dock is displayed vertically. Default: off 

Act on One Click
Applications in the Helper Dock are normally launched with a double mouse- click. To launch them 
on a single mouse-click, enable this option. Default: off 

Never Hide
The Helper Dock is a so-called floating window. When URL Manager Pro is not active, this floating 
window is hidden. To always show the Helper Dock, for example when you want to use it as a drop 
destination target, enable this option. Default: off 

Screen Font
Using Mac OS 8.5 or Mac OS 9, the screen font that URL Manager Pro uses can be set by specifying 
the Views Font in the Appearance Control Panel (first click the Fonts tab). You can also use Internet 
Config's setting. See below. 

Note: On Mac OS X it not yet possible to change the screen font. 

Use IC Font
If you don't want to change your Appearance setting, enable this option. It instructs URL Manager Pro 
to use the 'List Font', which is specified in Internet Config. On previous Mac OS systems the screen 
font can be set in Internet Config. You may need to relaunch URL Manager Pro for the change to take 
effect. 

Printing

Print Notes
To have URL Manager Pro print the contents of Notes fields when you print a listing of URLs, enable 
Print Notes. Default: off 

Print Icons



To have URL Manager Pro print URL icons when you print a listing of URLs, enable Print Icons. 
Default: off 

Shared Menus

Preferences

Disable Shared Menus
To disable Shared Menus, check this preference. 

In most cases, you will not need to disable Shared Menus. However, this option is included in case 
Shared Menus conflicts with applications you are using. 

In particular, you would disable Shared Menus if you do not want the Shared Menus Component 
(SMC) to be installed. Normally, at launch time, when the SMC is not installed, URL Manager Pro 
will ask permission to install the SMC. To prevent URL Manager Pro from asking this each time at 
launch, you need to enable this preference (i.e. Disable Shared Menus). 

Note: Additional Shared Menu preferences can be found in the Shared Menus preferences help book. 
See Shared Menus Help. 

Miscellaneous

HTML Export Parameters

Use Japanese Character Set
Use this option when you want to export a bookmark file with Japanese bookmarks. Default: off 

HTML Editor

Choose...
Use this button to set yout preferred HTML Editor. Default: BBEdit 

Global Hot Key

Install Global Hot Key
You can install a global hot key. You can use this hot key to cycle through your open bookmark 
documents. It also cycles Shared Menus and Dock menus. The hot key works in all applications, 
including your web browser. Default: off 

help:openbook=Shared%20Menus%20Help


Windows

Add Bookmark Window

When the Add notes option is enabled (see Preferences from the Diamond Shared Menu), the Add 
Bookmark... command of the Diamond Shared Menu and the Add Bookmark... command of the 
Bookmarks Shared Menu display the Add Bookmark Window (see below). 

 

When using the Add Bookmark... command from the Diamond Shared Menu, the Bookmark will be 
added to the Drop Basket folder. When using the Add Bookmark... command from one of the 
submenus of your Bookmarks Shared Menu, the Bookmark will be stored directly in the 
corresponding folder. In the example below, the Bookmark will be stored in the "Newspapers" folder. 

 

By default, the title of the Web page is displayed as the name of the bookmark, but you can enter any 
text you wish. 

In the empty box underneath, the note field, you can enter a description of this Bookmark. This is 
useful for keeping pertinent information about this Bookmark. 

Note: The note field can contain up to 255 characters. 



Press Add to actually add the Bookmark to your Bookmark file. 

Get Info Window

To see a Get Info Window, first select a Bookmark, then choose Get Info from the Bookmarks 
menu. Going from top to bottom, you see the following items: 

●     Folder: the folder the Bookmark is located in
●     Name: the name or title assigned to a Bookmark
●     URL: the URL address
●     Note: a description of the Bookmark

Note: If you add a text to the Note field, a Clipboord icon will be displayed just to the left of the 
Bookmark's URL in the main bookmark window. 

Tip: If Balloon Help is switched on, you can read the contents of Bookmark note simply by passing 
the mouse pointer over the Cliboard icon. The text of the note will be displayed in a Balloon Window. 

Bookmark attributes
The attributes box displays technical information about a Bookmark. 

Always Reload
Switch this option on to force your browser to ignore a cached copy of this Web page and force 
reloading. Check this option for Web pages that you know are updated frequently, such as those on 
the Web site of newspaper, for example. Default: off 

Lock URL
Switch this option on if you do not want to validate this URL and want this URL fixed. Default: off 

Non Anonymous Access
Switch this option on to add a username and password to this Bookmark. Two fields, Username and 
Password, will be displayed. Fill these in as appropriately. You can use this feature for password-
protected Web pages. URL Manager Pro will add the username and password to the Keychain. When 
you later open this bookmark, URL Manager Pro will look up the username and password in the 
Keychain. Default: off 

Note: URL Manager Pro supports he Apple Keychain 

Query Type 
A URL can be a query. This URL does not point to a static Web page but submits a request for 
information, usually to an online database, the moment you select this URL. The Web page that is 
displayed is generated dynamically, that is to say, it displays the information, which is found in the 
database at that very moment. As a result, the results of a query can change from day to day. If you 
switch Query Type option on, the icon of the Bookmark will change, and a question mark will be 



displayed. This is to help you remember that this Bookmark is a query. 

Example: for example, this URL you would give the Query Type icon:

http://finance.yahoo.com/m5?a=1&s=USD&t=EUR&c=0

which gives you the exchange rate of the Euro against the Dollar. 

Tip: A typical Query Bookmark is a URL containing an AltaVista query. When you enter one or more 
keywords in the AltaVista search field and click search, AltaVista composes, on the fly, a URL out of 
this query. When its search results are displayed, you will see this URL, which can be rather long, in 
the Location line of your Web browser. If you save this URL as a Bookmark in URL Manager Pro, 
you save the query too. The next time you open this Bookmark, the query will automatically be 
submitted to the AltaVista search engine and the results will be displayed. 

Added On 
Date the Bookmark or folder was created on your system. 

Last Checked 
The date at which this URL was last validated by using the Validate command of the Bookmarks 
menu. 

Note: This date is not the date of the most recent visit. 

Browser popup menu 
You can use this popup menu to associate a bookmark with a specific browser. The browser popup 
menu lists the browsers: Default, Explorer, Netscape, iCab, Opera and OmniWeb. By default, a 
browser is opened in your preferred browser, a setting in Preferences/Internet. However, when you 
select a browser from the popup menu, the bookmark will be opened in that specific browser instead. 

Add/Edit... 
Use this button to edit username and password of a bookmark. The Keychain will be updated with the 
new information. 

In addition to the information displayed about a Bookmark, the Get Info Window also has four 
navigation buttons, at the upper right-hand corner of the window. These enable you to move to the 
next or the proceeding Bookmark without having to open and close the Get Info Window. 

History Window

The History window maintains a list of the Web pages you have visited. The History is helpful to help 
you backtrack when you are surfing the Web. Sometimes, you will forget to make a Bookmark for a 
Web page. With History, you can find the page again easily. By default, History keeps the last one 
thousand URLs you have visited. 



Note: URL Manager Pro tracks the History of all open browsers (Explorer, OmniWeb, Navigator, 
Opera and iCab) simultaneously. 

Tip: To make URL Manager Pro load faster, you can configure History in the Preferences Window to 
maintain the list of only the last one hundred URLs you have visited. 

You can perform many of the same commands on Bookmarks in the History window as Bookmarks in 
the Bookmarks window, including Find. Two useful commands for the History window are displayed 
in small popup menus at the bottom of the History window. 

Sort
The Sort menu offers you four sorting criteria for the History window: Name, URL, Date, and Label. 
By default, the History window is unsorted, but Bookmarks will generally be displayed in the order in 
which you visited sites. 

History Enabled/Disabled
With these commands you can toggle History on and off. 

Tip: For reasons of confidentiality, it may be useful to switch the History off temporarily. It is also 
possible to delete URLs individually from History by selecting a URL and using the Clear command 
in the Edit menu or by pressing Backspace. This is useful if a URL contains a password to a 
protected site and your computer is used by other people. 

Favorites Window

To open the Favorites Window, choose Edit Favorites... from the Edit menu. This window contains 
five tabs: Favorites, Explore, Friends, FTP and Daily. 

These tabs are designed for Bookmarks. To add a Bookmark to one these five tabs, first click the 
appropriate tab and then drag it from a document window and drop it on the Favorites Window. You 
can access these favorites sets of bookmark via the Diamond Shared Menu. 

You can also access the Bookmarks stored on Favorites tabs by means of menu extra or menulet 
Mondriaan (Mac OS X) or the Control Strip Module Mondriaan (Mac OS 9). Mondriaan allows you 
to access these Bookmarks even when URL Manager Pro is not running. 

 

The Mondriaan menu extra or 'menulet' 

Favorites 
The Bookmarks displayed in the Favorites tab will also be displayed in the Favorites submenu found 



on the Diamond Shared Menu in your web browser. 

Explore 
You can also access the Bookmark icons displayed on the Explore tab using URL Manager Pro's 
Explore menu. Explore is also a submenu of the Diamond Shared Menu in your web browser. 

Tip: We have "pre-loaded" the Explore page for you with a collection of interesting Web sites you 
might find interesting to explore. As you explore the Web, feel free to replace our selection with 
Bookmarks of your own. Enjoy! 

Friends
The Friends tab is designed for email address Bookmarks. To add an email address Bookmark this 
tab, drag it from the Bookmark window and drop it on the Favorites Window. 

You can also access the email address Bookmarksdisplayed on the Friends tab using the Friends 
submenu on of the Diamond Shared Menu in your email program. 

FTP
The FTP tab is designed for FTP site Bookmarks. To add an FTP Bookmark to this tab, drag it from 
the Bookmark window and drop it on the Favorites Window. 

You can add a user ID and password for accessing protected FTP sites by selecting an FTP Bookmark 
on the FTP tab and clicking the User ID button next to the Favorites Window tabs. A dialog box will 
be displayed where you can enter your User ID and your Password. 

Note: For security reasons, once you have entered your password, it will not be displayed if you click 
on the User ID button again or use the Get Info command. 

Note: When the Keychain is installed, URL Manager Pro will store the User ID and Password in the 
Keychain instead of in the Bookmark file. 

The Bookmarks displayed on the FTP tab of the Favorites Window will also be displayed in the Save 
As command under Remote on the File menu. You can also access the Bookmark icons displayed on 
the FTP tab using the FTP submenu on URL Manager Pro's Diamond Shared Menu in your FTP 
program. 

Daily
The Daily tab is designed for a small number (say five) of Web sites that you would like to view 
everyday. If you click on the Browse All button, URL Manager Pro will open all the Web pages in 
separate windows in your Web browser. 

The Read Daily command of the Diamond Shared Menus is functionally equivalent to the Browse All 
button. 



Tip: Many of URL Manager Pro's Bookmark commands can be used in the Favorites pages as well, 
such as Add Bookmark and Insert Separator. You can also sort the Bookmarks you have here. 
However, you cannot add a folder to a Favorites page. 

Tip: URL Manager Pro opens your Daily Bookmarks in separate Windows and they are loaded 
concurrently. You can start reading the Web page that loads first while the others are loading. 

You can also access the Bookmarks stored on Favorites pages by means of URL Manager Pro's 
custom Control Strip Module Mondriaan (Mac OS 9) or menulet Mondriaan (Mac OS X). Mondriaan 
allows you to access these Bookmarks even when URL Manager Pro is not running. 

For more information about Mondriaan, go to the Mondriaan Web Page. 

Delete Window

The Delete... command of the Clean Up submenu is similar to the Delete Duplicates command in the 
Edit menu, but offers you a several additional options. To use the Delete... command, issue the Find 
Duplicates or Validate command first. These commands will check all the URLs in the current 
Bookmark file and mark them accordingly, such as whether a URL is a duplicate, is broken, etc. The 
Delete Window offers the following options: 

Duplicate URLs
To delete all Duplicate URLs in the current Bookmark file, enable this option. 

Broken Links
To delete all URLs with broken links in the current Bookmark file, enable this option. 

Unknown Status
To delete all URLs with an unknown status in the current Bookmark file, enable this option.

Don't Delete but Move
This option gives you the opportunity to review URLs to be deleted. Instead of deleting them, 
they are moved to the Waste Basket.

Note: If you are certain the URLs marked using the Validate command are safe to delete, leave this 
option off, otherwise enable it. 

Helper Dock

The URL Manager Pro Helper Dock puts all of your Internet applications within easy reach, just a 
mouse click or two away. 

If you select Helper Dock from the Window menu, the Helper Dock will appear at the bottom of your 
screen. By default, it contains the following ten icons of your Internet applications. 

To display the Helper Dock without labels, click the zoom box. 
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The first seven of these Internet applications are programs assigned in the Internet Control Panel (or in 
Internet Config for users of Mac OS versions prior to 8.5). These are the default applications for each 
of the seven URL protocols (see Uniform Resource Locators Explained). 

The two applications on the right-hand side are Internet utilities: Remote Access and URL Manager 
Pro. The Remote Access icon opens a Control Panel to initiate a PPP connection. On Mac OS X and 
also when you have a direct connection to the Internet, the Remote Access icon is not shown. 

Note: You can not configure the URL Manager Pro Helper Dock directly by dropping a program icon 
on it. You have to configure your Internet preferences using the Internet Control Panel. Changes to 
this will be reflected in the Helper Dock. 

Note: Under Mac OS versions 8.5 and earlier, Helper Dock is a standard application window and can 
be covered or overlapped by other windows. On Mac OS 8.6 or higher, the Helper Dock is a true 
floating window. 

Note: The floating window is hidden when URL Manager Pro is not active. To show the Helper Dock 
always, enable the preference 'Never Hide'. 

Tip: By default, the Helper Dock is displayed horizontally. However, on the Look & Feel tab of the 
Preferences Window, you can configure Helper Dock to be displayed vertically. 

To launch a program, double-click on its icon. 

Tip: By default, you launch a program in the Helper Dock with a double mouse click. However, on 
the Look & Feel page of the Preferences Window, you can configure Helper Dock to launch programs 
with just one click. 

The Helper Dock makes extensive use Drag & Drop. Using the mouse cursor, drag a Bookmark icon 
and drop it on a program icon. The program will be launched and open this URL. If you select 
multiple URLs, drag & drop them on a program icon, your Internet application will open these URLs 
in multiple windows. 

Tip: You can Drag & Drop hypertext links from a Browser window to the URL Manager Pro 
application icon (the right-most icon). 

Tip: If you drop an email Bookmark on a Helper Dock program icon, your email program will be 
launched with a new Message Window and the email address specified in this Bookmark in the To: 
field. 

If you have the PPP Control Panel or Remote Access Control Panel installed, URL Manager Pro will 
automatically add this Control Panel to the Helper Dock. 

On Mac OS X, the application 'Internet Connect' will be added to the Helper Dock. 



If you place aliases to your AOL or CompuServe applications into the same folder as URL Manager 
Pro, the AOL or CompuServe icon will appear in the place of the PPP icon (Mac OS 9 only). 



Reference
Elements of the URL Manager Pro interface

The main elements of a Bookmark file (a URL Manager Pro document window) comprises (from top 
to bottom) the Toolbar, the Header line, the scrollable display of Bookmark and folder icons and the 
URL line. 

The URL Manager Pro Toolbar
The URL Manager Pro Toolbar offers you quick access to your most important Internet applications 
and access to the main features of URL Manager Pro. 

 

It is possible to hide the Toolbar in Preferences. On Mac OS X, you can use the Toolbar button in the 
window title bar to toggle the toolbar on and off. See below for a screenshot of the Mac OS X Toolbar 
icon. 

 

The URL Manager Pro Toolbar comprises the following buttons: 

WWW
The WWW button launches your Web browser. 

Email
The Email button launches your email program. 

Home
The Home button launches your Web browser and opens your Home Page. 

Sort
The Sort button sorts selected Bookmarks and Bookmark folders. When you click on it, a popup menu 
is displayed, offering you four sorting criteria. 



You can sort by: 

●     Name
●     Date
●     URL
●     Label
●     No Order

You can remove sorting order by selecting the fifth option. Sorting selections: 

If no Bookmarks or folders are selected, all top-level items are sorted. If a folder is selected, only its 
contents will be sorted. If two or more Bookmarks are selected, only those items are sorted. 

Tip: You can set the sort attribute of a folder using the folder Contextual Menu (Control-Click). 

Tip: If you enable the preference Automatically Sort Folders, the contents of a folder will always be 
sorted when its folder sort attribute is set. This applies in the case a bookmark is added via Add 
Bookmark from the Shared Menus. The added bookmark is added in its sorted position. 

Find
The Find button displays the Find Window which enables you to search for a string of text. 

 

It offers three options: 

●     Wrap Around: start the search from the current Bookmark and continue the search from the top 
of the Bookmark file. Default: off

●     Ignore case: perform case insensitive searches. Default: on
●     Net Search: perform a search for a Macintosh file (either a file, like movies or pictures, or 

applications, like shareware and freeware programs) on Mac FTP sites on the Web using 
Anarchie or Interarchy.

If the text is found in a Bookmark, you can click one of the following buttons: 



●     Open URL: Open this Bookmark in the relevant application
●     Copy Name: Copy the name of the Bookmark to the Clipboard
●     Copy URL: Copy the address (URL) to the Clipboard

Or you can continue the search by pressing Find Again (  G). 

Info
The Info button displays the Get Info Window, where you can view and modify the details of a 
Bookmark. For more information about the Get Info Window, see Get Info Window. 

Faves
The Favorites button opens the Favorites Window. The Favorites Window is a place where you can 
store a small number of frequently used Bookmarks. 

Pref
The Preferences button opens the Preferences Window. For information about configuring URL 
Manager Pro, see Preferences. 

Save
The Save button saves the current Bookmark file to disk. The position of windows and status of 
folders (open/closed) is also saved to disk when the option Remember Position and Size is enabled in 
Preferences. 

Finder
The Finder button switches you to the Finder. 

The URL Manager Pro Header line
The URL Manager Pro Header line, which is directly under the Toolbar, displays some useful 
information about the current Bookmark file. It also provides you access to the URL Manager Pro 
Cabinet popup menu. It is shown on the left-hand side of the Name label. 

 

Black diamond

On the left-hand side of the Cabinet popup menu, a small black diamond is displayed when the 
contents of the current document have been changed and not yet saved. When only the window 
position of the Bookmark file has moved, a small hollow diamond is displayed. 

Tip: Clicking the black diamond will save your Bookmark file. 



Note: If Auto Save is turned on, the diamond will disappear each time Auto Save saves any changes 
to disk. 

Cabinet popup menu

On the right-hand side of the black diamond is the Cabinet popup menu. The bookmarks file(s) you 
put into the Cabinet folder will appear as menu items on the Cabinet popup menu. The Cabinet folder 
must be in a well-defined location. More information in Preferences. Select a menu item of the 
Cabinet popup menu to open that Bookmark file. 

 

The last item of interest on the header line is the items number on the right-hand side. This is the 
number of Bookmark icons and folders displayed in the current window. It does not include icons and 
folders contained in closed folders. If you open a folder, this number will be augmented to reflect the 
actual number of items on view. 

The URL Manager Pro URL Line
At the bottom of the URL Manager Pro file window, the URL Line is displayed. This displays the full 
URL of the currently selected Bookmark. 

 

Tip Even when the URL Manager Pro bookmark window smal horizontally, you can still view the 
entire URL of a Bookmark by selecting an URL with the mouse and viewing this line. 

The URL Manager Pro Document Window
URL Manager Pro displays Bookmark icons in a convenient, easy-to-navigate hierarchical structure. 
A URL Manager Pro document window is also called a Bookmark file window. 

Bookmark Icons
In the URL Manager Pro document window, a URL is represented by a Bookmark icon. To the icon's 
right, its name or title and the address of the URL are displayed. 

To select a Bookmark, you click once on its icon. 

To edit its name or title, click once on its text. 



To edit its URL, click once on its text. 

Use TAB to move from the name field to the URL field 

Use ENTER to stop editing 

The standard Mac text editing commands (Undo, Cut, Copy, and Paste) can be used in editing these 
two texts. 

Note: Edit URLs with caution. An error will make a URL unusable. 

When a Note has been entered for a Bookmark, a Note icon is displayed on the left-hand side of the 
URL. 

Tip: Enable Balloon Help with the Help menu and move your mouse pointer over the Note icon. The 
Note will be displayed in a Balloon Window. 

When the attribute Non Anonymous Access has been enabled for a Bookmark, a Lock icon is 
displayed on the left-hand side of the URL. For more information see Get Info Window 

Folder Icons
A folder contains Bookmarks. A triangle (actually, a disclosure triangle) indicates whether a folder is 
open or closed. 

This triangle can also be used to open and close a folder by clicking on it once. You can also open and 
close a folder by double clicking the folder icon. 

Tip: Option-Click on the triangle displays or closes the whole hierarchy of the enclosing folders. 

When you set the Bookmark attribute Lock URL in the Get Info Window, a small Lock icon is 
displayed left of the Bookmark icon. 

Bookmark/Folder/Document Contextual Menu
If you press the Control key and click on a Bookmark or folder, the Bookmark or Folder Contextual 
Menu will be displayed. These menus contain a number of useful commands for manipulating 
Bookmarks and folders. Control click on white space display the Document Contextial menu. 

Tip: Users with large monitors in particular will find the Bookmark and Folder Contextual Menus an 
extremely efficient way to manipulate Bookmarks and folders, since it saves having to move the 
mouse pointer to the menu bar for many common operations. 

See Contextual Menus for additional information about these commands. 

The URL Manager Pro Menu Commands



The Command (Cmd) key is indicated on the keyboard with the cloverleaf icon. 

File menu

The File menu contains the following commands: 

New
The New command creates an empty Bookmark file (a URL Manager Pro document). When you save 
it for the first time, you will be prompted for a distinctive filename. 

Open,  O
The Open command provides you with a file selection dialog with which you can open an existing 
Bookmark file from on your hard disk or from a floppy disk. 

Open Recent
The Open Recent submenu lists the ten last files opened. 

Quick Open
The Quick Open submenu lists the files found in two folders: Startup Items and Cabinet. For more 
information see: Special Features. Quick Open is a convenient way to open frequently used files 
without going through the file selection dialog. 

Close,  W
The Close command closes the currently active Bookmark file. If you have modified it, you will be 
prompted to save changes before closing it. 

Save,  S
The Save command writes the currently active Bookmark file to disk. Functio- nally equivalent to the 
Save button on the Toolbar. 

Save As
The Save As command enables you save the currently active Bookmark file under a different name. 

Revert to Saved
The Revert to Saved command enables you retrieve the previously saved version of the currently 
active Bookmark file as stored on disk. Use this command to undo changes you have made to the 
currently active Bookmark file. 

Grab All
The Grab All command displays a submenu displaying the following Grab All options: Web Page, 
Email Message and News Article. 

Web Page



URL Manager Pro will extract all URLs from the current Web page in your preferred Web browser. 

Email Message 
URL Manager Pro will extract all URLs from current email message. 

Tip: You can use this option to extract all the URLs from an email E-Zine article (TidBits, for 
example). 

Note: The applications Eudora, Outlook Express, Mailsmith and Claris Emailer 2 support this 
command. 

News Article URL Manager Pro will extract all URLs from current news article. 

Tip: You can use this option to extract all the URLs from a News article (Info-Mac Digest, for 
example). URL Manager Pro has special code to read all the Info-Mac relative URLs and save them 
as FTP Bookmarks. 

Note: Only the application YA NewsWatcher supports this command. 

Tip: The Grab All is also found in the Diamond Shared Menu in your Internet application. 

Get from Browser
The Get From Browser command imports your browser's favorites or bookmarks and displays it has a 
new URL Manager Pro bookmark file. The sub menu lists all browsers URL Manager Pro currently 
supports. URL Manager Pro knows about the default location of these files. However, if you have a 
browser bookmark file which is not in its default location, you can use the last command of the sub 
menu, i.e. Select Bookmark File. 

Save to Browser
The Save to Browser command exports the current open URL Manager Pro document as a Bookmark 
file to your browser. The sub menu lists all browsers URL Manager Pro currently supports. 

Import
The Import submenu displays a submenu displaying the following Import options: 

Scan Text
The Scan Text command displays a file selection dialog with which you can select a text file to open. 
URL Manager Pro will scan this file for URLs and display them in a new Bookmark window. The 
name of this Bookmark file will be assigned the name of the text file. 

Scan Clipboard
The Scan Clipboard command scans text copied to the Clipboard. It will display the URLs it finds in 
an untitled Bookmark file. 



Import Tab Delimited
The command displays a file selection dialog where you can select a tab delimited text file to open. 
The format that URL Manager Pro accepts for a tab delimited text file is: [name] TAB [url] 
TAB [description] CR 

Tip: The tab-delimited format is a useful way of importing URLs from a database such as FileMaker 
Pro. 

Eudora Address Book
The Eudora Address Book command imports the Eudora Address Book and displays email addresses 
as a new Bookmark file. The name of this Bookmark file will be assigned the name Eudora Import. 
Each email address will be represented by an email Bookmark icon. Its name will be the Eudora 
Nickname. The Notes field in Eudora will be converted to a Note field in URL Manager Pro. 

Entourage Address Book
The Entourage Address Book command imports the Entourage Address Book and displays email 
addresses as a new Bookmark file. 

Note: Eudora or Entourage must be running for this command to function. 

Tip: To import Claris Emailer Address Groups, use Drag & Drop: drag an Address Group and drop it 
onto the URL Manager icon in the Helper Dock or an active URL Manager document window. 

Navigator Address Book
The Navigator Address Book command imports the Navigator Address Book and displays email 
addresses as a new Bookmark file. 

Outlook Express Address Book
The OE Address Book command imports the OE Address Book and displays email addresses as a new 
Bookmark file. 

Export
The Export menu item is a submenu giving you four Export options. 

Export As Text
If you want to export your bookmarks to a database, such as FileMaker Pro, choose Export As Text. If 
you select a folder, only the folder will be exported. The format of the exported text file is: [name] 
TAB [url] TAB [description] CR 

Export As HTML
Exports your Bookmark file to HTML format. If you select a folder, only the folder will be exported. 

Note: This format is the same format as the format Web browsers use for their Bookmark files. 

Tip: You can use this command to bring over your Bookmark file to a Windows PC. You should save 



the file with a .html extension in the filename. 

Export As Aliases
This commands exports your mailto: bookmarks to a UNIX format, i.e.:
alias name email address 

Export Email Addresses
If you only want to export your mailto: bookmarks (email addresses) choose Export Email Addresses. 

Remote
Using the Remote command, you can store a Bookmark file in a central location and retrieve it at a 
remote site when you need it. This command facilitates using URL Manager Pro on multiple 
computers in different locations. 

To use Remote, you will need to have access to an FTP server. You will also need to have read/write 
access to a given subdirectory. 

Tip: The Remote command is useful if, for example, you use URL Manager Pro on both your office 
and your home computers. Rather than transfer your URL Manager document between your two 
computers by floppy disk, you can simply pick up the document using Remote at the beginning of 
your session. If you update your file, you use Remote to replace it again at the end of your session. 

Note: We recommend that you do not store your Bookmark files in public or anonymous FTP 
directories. Some of your documents may contain confidential information, such as passwords (this is 
not the case when you have Apple's Keychain installed). If you use the Remote command, store your 
documents in a password- protected FTP directory. 

Note: The remote command is not designed for concurrent users, unless files are used strictly on a 
read-only basis. URL Manager Pro cannot merge changes made to multiple copies of a Bookmark 
file. The Remote command displays a submenu displaying the following Remote options: 

  Get
The Get command downloads your Bookmark file from your FTP server to your computer. 
The Bookmark file must have been stored in MacBinary II format. The name of the file to get 
and the address of your FTP server are configured using the Remote Preferences command 
(see below).

  Save
The Save command uploads your Bookmark file from your computer to your FTP server. It 
uses MacBinary II format to store the file. The name of the file will be the name of the 
Bookmark window plus a '.bin' extension, which will be added automatically. The address of 
your FTP server is configured using the Remote Preferences command (see below).

  Save As
The Save As command uploads your Bookmark file from your computer to your FTP server in 
several formats.



Note: URL Manager Pro uses Fetch, Interarchy or NetFinder to do the actual file transfer. Either one 
of these programs must be installed on your system for the Remote commands to work. 

Tip: When Fetch is used to upload your Bookmark file, URL Manager Pro sets the upload mode in 
Fetch to MacBinary II. 

Remote Preferences
With the Remote Preferences command, you can configure the Remote commands. You will need to 
specify an FTP site and a valid filename. Add your FTP site to the FTPs set in the Favorites Window. 
The bookmark should specify a directory, so please end the path with a slash ('/'). 

The filename is the name of the MacBinary II file at the remote FTP site and is used for the Get 
command. Do not add a filename extension. URL Manager Pro will do this automatically. 

For the actual FTP operation, you can use Interarchy, Fetch or NetFinder. 

Tip: To have Remote Preferences displayed, hold down the Option key when choosing either Get or 
Save. 

Note: If you add or delete entries from the FTPs set in the Favorites window, you need to choose the 
Remote Preferences command again. Select your default FTP server in the popup menu. This will 
ensure that the Save and Get command will use the right FTP server. 

Index File
The command uses Sherlock to index the current open Bookmark file. The section Sherlock has more 
information about this command. 

Environment Info 
The Environment Info command displays technical information about URL Manager Pro. This 
includes the path and size of the current document, the size of all documents open and free memory. 

Note: Under most circumstances, URL Manager Pro's default memory allocation of 2048 Kb is 
sufficient. If you have files of many thousands of Bookmarks, you may find you run low on memory. 
To allocate more memory to URL Manager Pro (Mac OS 9 only): 

Quit URL Manager Pro, 

Go to the Finder and select the URL Manager Pro icon, 

Select the Get Info command on the File menu. 

Under Memory, you can increase URL Manager Pro's memory allocation. 

Page Setup



The Page Setup command displays the standard Page Setup dialog box that is appropriate to your 
printer. On Mac OS X printing is not yet supported. 

Print,  P
The Print command allows you to print the currently active Bookmark file. Printing in colour is 
supported. On Mac OS X printing is not yet supported. 

Note: Several options in the Preferences Window influence the way the printout will look. 

Quit,  Q
The Quit command allows you to exit URL Manager Pro. If any documents are open and changes 
have not been saved, you will be prompted to saves changes first. 

Edit menu

The Edit menu has the following commands: 

Undo,  Z 
Undo the most recent change. Only works for text editing commands. 

Cut,  X 
Move the currently selected Bookmark or text to the Clipboard 

Copy,  C 
Copy the currently selected Bookmark or text to the Clipboard. 

Paste,  V 
Paste the contents of the Clipboard at the cursor location. 

Clear 
Delete currently selected Bookmark or text. 

Select All,  A 
Select all Bookmarks in the currently active document window. 

Edit Bookmark 
The Edit Bookmark command highlights the title of the currently selected Bookmark icon. You can 
use the standard Macintosh editing features to edit this text. Press the Enter key when you are 
finished. 

Tip: You can also edit a Bookmark simply by clicking on its name. 

Edit Favorites,  T



The Favorites command opens the Favorites Window. The Favorites Window is a place where you 
can store a small number of frequently used Bookmarks. 

Find,  F 
The Find command displays the Find Window. With it, you can search in your Bookmarks for a string 
of text. It offers three options: 

●     Wrap Around: start the search from the current Bookmark and continue the search from the top 
of the Bookmark. Default: off

●     Ignore Case: perform case insensitive searches. Default: on
●     Net Search: perform a search of Mac FTP sites using Anarchie or Interarchy. If you switch this 

option on, URL Manager Pro will search the Web, not the current Bookmark file. Default: off

Find Again,  G 
The Find Again command repeats previous Find operation. It bypasses the Find Window command. 

Find on Disk,  F 
This command uses the Sherlock engine to search your Bookmarks folder or hard disk for words in 
Bookmark files. Use the command Index Bookmarks below to index them. If you want to search 
your whole hard disk, you must have indexed it with Sherlock. Your Bookmarks folder you can index 
with the menu command below. 

Index Bookmarks
This command uses the Sherlock engine to index all your Bookmark files in this folder:
~/Documents/Bookmarks/. 

Delete Duplicates,  D 
The Delete Duplicates command searches for and deletes all duplicate URLs. It compares the actual 
URLs, not the names you've assigned them as Bookmarks. There is no Undo for this command. 
However, if you do accidentally delete a Bookmark with Delete Duplicates, the Revert To Saved 
command in the File menu will restore all changes made since you last saved the Bookmark file. 

Tip: If you want to view duplicate Bookmarks before deleting them, use the Find Duplicates 
command in the Cleanup submenu on the Bookmarks menu. 

Preferences 
The Preferences command opens the Preferences Window This command is functionally equivalent to 
the Pref button on the Toolbar. 

Bookmarks menu

The Bookmarks menu has the following commands: 

New Bookmark,  N 



The New Bookmark command adds a new Bookmark after the currently selected Bookmark in the 
URL Manager Pro document window. If no Bookmark folder is currently selected, it will be added at 
the bottom of the list of Bookmarks. 

The new Bookmark will be called "Untitled" and the URL will contain only the default protocol, 
http:// Its name will be selected and highlighted, prompting you to give it a more meaningful 
name. 

Add Bookmark 
The Add Bookmark command is greyed-out on the Bookmarks menu unless a closed folder is selected 
in the URL Manager Pro document window. If this is the case, you can select the Add Bookmark 
command, and a new Bookmark will be added to the currently selected closed folder. This folder will 
be opened and the new Bookmark will be selected. The new Bookmark will be called "Untitled" and 
the URL will contain only the default protocol, http:// Its name will be selected and highlighted, 
prompting you to give it a more meaningful name. 

New Folder,  N 
The New Folder command adds a new folder after the currently selected Bookmark in the URL 
Manager Pro document window. If no Bookmark is currently selected, it will be added at the bottom 
of the list of Bookmarks. 

Insert Separator
The Insert Separator command adds a divider line underneath the currently selected Bookmark. 

Separators are useful when you are arranging large collections of Bookmarks. The separators you 
define in a Bookmark file are also displayed in Shared Menus. 

Get Info,  I 
The Get Info command displays the Get Info Window where you can view and modify the details of a 
Bookmark. 

Add Web Page,  K 
The Add Web Page command creates a Bookmark in your Bookmark file of the current Web page in 
your preferred Web browser. If multiple windows are open in your browser, the page in the topmost 
browser window is saved. By default, it is placed after the selected Bookmark or folder, otherwise in 
your Drop Basket folder. 

Add As Query 
The Add as Query command is similar to the Add Web Page command above, except that the URL 
will be saved as a Query Bookmark. By default, it is placed after the selected Bookmark or folder, 
otherwise in your Drop Basket folder. 

Open in Helper 
The Open in Helper command opens a Bookmark in the appropriate Internet application for its type, 



based on its protocol. See also URLs Explained. You can configure Internet application assignments 
in the Preferences Window. 

Open in Browser,  O 
The Open in Browser command opens a Bookmark in your Web browser, regardless of its type. 

Tip: This command is useful, for example, for opening FTP sites in your Web browser. Many FTP 
sites have Web interfaces, but some do not. You might find it easier to navigate an FTP site using a 
Web browser than using an FTP program. 

Sort
The Sort command sorts selected Bookmarks and Bookmark folders. When you select the Sort 
command, a Drop-Down menu is displayed, offering you four sorting criteria. You can sort by: 

●     Name
●     Date
●     URL
●     Label
●     No Order 

You can remove sorting order by selecting the fifth option. If no Bookmarks or folders are selected, 
all top-level items are sorted. If a folder is selected, only its contents will be sorted. If two or more 
Bookmarks are selected, only those items are sorted. 

Label 
The Label command allows you to change the colour of Bookmarks and folders, provided, of course, 
you have a colour monitor. 

Tip: By arranging, sorting, and labelling your Bookmarks with color, you will be able to manage very 
large collections with ease. Use color to indicate the status or priority of a Bookmarked Web page. 

Clean Up 
The Clean Up command displays a submenu with the following commands: 

Validate 
With the Validate command, you can check whether the URLs of your Bookmarks are still valid. 

When URL Manager Pro is finished validating Bookmarks, each Bookmark icon will have one of the 
following small marks next to it. Possible results are: 

●     Moved (←), 
●     Valid (√), 
●     Broken (x), 
●     Unknown (?).



If URL Manager Pro discovers that the URL of a Bookmark has moved, it will update the URL 
automatically. 

Note: If you want do not want the URL to be changed in any way, enable the Lock URL attribute via 
the Get Info Window. 

These marks are saved when you close the Bookmark file. 

Note: Currently URL Manager Pro does not validate FTP URLs. 

Find Duplicates 
The Find Duplicates command searches your Bookmark file for duplicate URLs. If it finds duplicate 
URLs, it places two small vertical red bars (||) next to the Bookmark icon. See the picture above. You 
can view the duplicates and then manually delete them one by one if you want, or you can use the 
Delete command (see below) to delete (or move) all duplicates. 

Delete 
The Delete command displays the Delete Window, which lets you specify which Bookmarks to delete 
or move. You can delete all broken links, those with unknown status and all duplicates. Instead of 
deleting them, you may decide to only move them to a special folder named Waste Basket. For more 
information, see the section Delete Window. 

Show Marks 
The Show Marks toggle command determines whether small marks are shown left of Bookmark 
icons. When the menu item is checked (Ã), marks are shown. If the menu item is not checked, no 
marks are shown. The marks display the results of the last Validate URLs command. 

Clear Marks 
The Clear Marks command removes the marks added by the Validate URLs command. It restores all 
results to their zero values. 

Edit in BBEdit,  J
The Edit In BBEdit command opens the current Web page in the HTML editor BBEdit. For more 
information about BBEdit, see the web site of Bare Bones Software. 

Tip: Using BBEdit, you can view, modify, and save changes to HTML and CGI script files stored 
remotely. By storing the URLs of these files in URL Manager Pro and editing them with BBEdit, you 
have a powerful tool at your disposal for the maintenance of Web sites. 

For example, I have this bookmark of my main Home Page:

http://www.url-manager.com/usr/home/alco/public_html/index.html 

The user ID and password for the site are in the Keychain and when I select this bookmark and choose 

http://www.barebones.com/


the Edit in BBEdit command, Interarchy is launched and the file index.html is subsequently opened 
in BBEdit for editing. When I am finished editing, choosing Save from BBEdit's File menu saves the 
file back to the web server. 

Get Web Site
The Get Website command allows you to retrieve all the Web pages from a web site or a directory on 
a web site. The file transfer is done using Interarchy, which must be installed on your computer. 

Outline menu

The Outline menu has the following commands. 

Expand 
The Expand command opens the currently selected folder and all its subfolders. 

Expand All,  ] 
The Expand All command opens all folders and all subfolders in a Bookmark file. 

Collapse 
The Collapse command closes the currently selected folder and all its subfolders. 

Collapse All,  [ 
The Collapse All command closes all folders and all subfolders in a Bookmark file. 

Move Left,  L 
The Move Left command moves the currently selected Bookmark or folder up a folder level (i.e., left) 

Move Right,  R 
The Move Left command moves the currently selected Bookmark or folder down a folder level (i.e., 
right). 

Move Up,  U 
The Move Up command moves the currently selected Bookmark or folder one position higher (i.e., 
right). If you are at the top of a folder, it will move the item up to the folder above. 

Move Down,  D 
The Move Down command moves the currently selected Bookmark or folder one position higher (i.e., 
right). If you are at the bottom of a folder, it will move the item up to the folder below. 

Tip: All the Move commands can be duplicated using Drag & Drop with the mouse. In addition, Drag 
& Drop also functions on multiple selections. 

Show in Dock - Mac OS X only



The Show in Dock command is only active when you have a folder selected. If you select a folder and 
use the Show in Dock command, URL Manager Pro will create a Mac OS X Dock Menu out of the 
contents of this folder, including all subfolders and Bookmarks in subfolders. This Dock Menu will be 
displayed in all applications. 

The Dock Menu you create will have the name of the top-level folder. When you use the Show in 
Dock command on a folder, its icon will change - indicating it is a Dock Menu folder. 

Tip: You can also turn a folder into a Dock Menu by Dragging & Dropping it on to the icon of your 
Web browser in the Helper Dock. 

Don't Show in Dock - Mac OS X only
The Don't Show in Dock command enables you to turn off the Dock Menu of a folder. Its menu will 
be removed from the Dock. 

Put Whole Document in Dock - Mac OS X only
To define the entire currently active Bookmark file as a Dock Menu, select the Put Whole Document 
in Dock menu command. 

Explore menu

The Explore menu contains the Bookmarks found on the Explore tab of the Favorites Window (see 
Favorites Window). Selecting a Bookmark from this menu is functionally equivalent to selecting a 
Bookmark from the Explore tab of the Favorites Window or selecting a Bookmark from the Explore 
menu on the Diamond Shared menu in your Web browser. 

Window Menu

The Window menu contains the following commands. 

Helper Dock,  H 
The Help Dock command shows or hides the Helper Dock. 

HTML Editor,  E 
The HTML Editor command launches your HTML Editor. This application is defined on the General 
tab in the Preferences Window. 

Email,  M 
The email command launches your email program. This application is defined in on the Internet page 
in the Preferences Notebook. 

WWW,  B 
The WWW command launches your Web browser program. This application is defined in on the 



Internet page in the Preferences Notebook. 

History,  H 
The History command displays or hides the History Window. 

Displayed below the Separator line on the Windows menu are the names of all currently open 
Bookmark files. 

Support menu

About Shortcuts 
This command shows an overview of some often-used shortcuts. 

About Internet Config 
This command tells more about Internet Config. This is the application to configure your Internet 
preferences. On Mac OS 8.5 and higher, you can use the Internet Control Panel. 

What's New 
This commands loads the 'What's New' Web page of the URL Manager Pro Web site into your current 
open browser window. 

Discussion List 
Use this command to subscribe to the mailing list of URL Manager Pro. It will prompt you for your 
name and email address and subscribe you automatically. 

FAQ 
This commands loads the 'Frequently Asked Questions' Web page of the URL Manager Pro Web site 
into your current open browser window. 

Customer Support - Registered Versions Only 
This command creates a new Message Window in your email application addressed to the Customer 
Support email address of URL Manager Pro. Please enter a subject in the subject line of the message 
and type the question or problem in the body of the message. This menu command is only available 
after you have registered and paid for URL Manager Pro. 

Contextual Menus

Contextual Menus are another advanced feature of Mac OS 8 and higher, which URL Manager Pro 
takes advantage of. Contextual Menus are displayed by Control-Click. 

Note: To Control Click an object, hold down the Control key and click it with the mouse pointer. 

To display the Bookmark Contextual Menu, Control-Click a bookmark icon. 



To display the Folder Contextual Menu, Control-Click a folder icon. 

To display the Document Contextual Menu, Control-Click 'white space'. 

Bookmark Contextual Menu
The Bookmark Contextual Menu offers the following commands: 

Open Bookmark(s)
The Open Bookmark(s) command opens the currently selected Bookmarks in their respective Internet 
applications. For example, a Web page Bookmark will be opened in your browser, an email 
Bookmark will be opened in you email program, etc. 

Tip: To select multiple contiguous Bookmarks, hold the Shift key while selecting them. 

Tip: To select multiple non-contiguous Bookmarks, hold the Command key while selecting them. 

Open in New Window
The Open in New Window command opens the selected Bookmark in a new Browser Window, rather 
than opening it in the currently active one. 

Open in Browser
The Open in Browser command opens the selected Bookmark in one of the listed Web browsers, 
regardless of its type. 

Note: The Open in Browser command overrides the protocol of the Bookmark, technically speaking. 

Tip: The Open in Browser command allows you to override the default Web browser setting defined 
in the Preferences Window. 

Sort Bookmarks
The Sort command sorts the currently selected Bookmarks. 

Copy to Clipboard
Copy to Clipboard command copies the URLs of the currently selected Bookmarks to the Mac 
Clipboard. The format of the URL is can be configured in the Preferences Window. 

Email Bookmark(s) To 
The Mail Bookmark(s) command allows you to send the URLs of currently selected Bookmarks to an 
individual listed on the command's submenu. These are Bookmarks of email addresses found the 
Friends tab of your Favorites Window. 

Email Bookmark(s) opens a new message in your Email program allowing you to view and modify 
the message before you send it. 



Email Document To 
The Email Document To command opens a new message window in your email program and appends 
the current URL Manager Pro Bookmark file as an attachment. If you have the StuffIt Engine in your 
Extensions folder, URL Manager Pro will automatically stuff the file. 

Save Bookmark...
The Save Bookmark command lets you save a Bookmark as a URL to disk. It creates an old-fashioned 
Netscape Bookmark URL. 

Note: It is preferred you Drag and Drop a Bookmark to the Finder Desktop. This creates a modern 
Mac OS Internet Location file. 

Get Info...
The Get Info displays the Get Info Window. 

Label
The Label allows you to color one or more Bookmarks. 

Folder Contextual Menu
The Folder Contextual Menu offers a subset of the Bookmark Contextual Menu commands. In 
addition, it includes: 

Sort
The Sort command sorts the selected folder. When you select it, a submenu is displayed, offering you 
four sorting criteria. You can sort by: 

●     Name
●     Date
●     URL
●     Label

You can remove sorting order by selecting the fifth option: No Order 
Show In Dock/Don't Show in Dock
Show in Dock defines this folder of bookmarks to appear as a popup menu on the URL Manager Pro 
icon in the Mac OS X Dock. 

Open in New Windows
The Open as New Windows command opens all the Bookmarks in a folder in new windows in their 
respective applications. 

Note: Be careful with this command. If you use it on a folder with many Bookmarks, you find you do 
not have sufficient resources to open all the documents. 

Document Contextual Menu



Sort Document
The Sort command sorts the whole document. 

Index Document
The Index commands uses the Sherlock engine to index this document. 

Put whole document in dock
With the Shared as Menu command, you can individually select URL folders to share. To share all the 
folders of your Bookmark file automatically, enable the Share Whole Document option. 

Note: This is a very powerful feature only available in Mac OS X. 

Email Document To 
The Email Document To command opens a new message window in your email program and appends 
the current URL Manager Pro Bookmark file as an attachment. If you have the StuffIt Engine in your 
Extensions folder, URL Manager Pro will automatically compress the file. 

You can email to an individual listed on the command's submenu. These are Bookmarks of email 
addresses found the Friends tab of your Favorites Window. 

Environment Info
The Environment Info command displays technical information about URL Manager Pro. This 
includes the path and size of the current Bookmark file, the size of all files open, and free memory. 

Special Features

URL Manager Pro has a number of special features and capabilities, which are not covered in the 
Command Reference. They are described below. 

The Cabinet folder

The Cabinet feature gives you quick access to your Bookmark files. It helps you skip the File Open 
dialog boxes and open your Bookmark files much more quickly. 

When URL Manager Pro is launched, it looks for a folder or alias called Cabinet in these locations: 

●     (Mac OS X)  -   ~/Documents/Bookmarks/ 
●     (Mac OS 9)  -   Hard disk:Documents:Bookmarks: 

Below an example of how it should look like on Mac OS X: 



 

If URL Manager Pro finds a folder named Cabinet in this location, it will display the names of the 
Bookmark files and aliases found in this folder in the Cabinet popup menu, which is accessed on the 
Bookmark file Status Line. Clicking on the little triangle button will show you can Cabinet popup 
menu. 

 

Note: the Bookmark files in the Cabinet folder will also be displayed in the Cabinet submenu of the 
Diamond Shared Menu in your Internet applications. 

Note: for backward compatibility on Mac OS 9, URL Manager Pro will also look in the URL 
Manager Pro folder for a folder named Cabinet. 

The Startup Items folder
When URL Manager Pro is launched, it loads all Bookmark files (and aliases to Bookmark files) 
found inside the Startup Items folder. It looks for a folder or alias called Startup Items in these 
locations: 

●     (Mac OS X)  -   ~/Documents/Bookmarks/ 
●     (Mac OS 9)  -   Hard disk:Documents:Bookmarks: 

Please look at the large image above (explaining the Cabinet folder) to understand it fully. 



You can also use the more simple preference 'Select Startup Bookmark file...' from Preferences, if you 
want to have a startup bookmark file. 

Tip: You can temporarily deactivate the Startup Items folder in the Preferences Window. 

Tip: Use the Startup Items folder for Bookmark files you want to have loaded at all times. Use the 
Cabinet folder for Bookmark files you only need to occasionally access. 

Note: for backward compatibility on Mac OS 9, URL Manager Pro will also look in the URL 
Manager Pro folder for a folder named Startup Items. 

Auto Start URL Manager Pro with your browser
You can configure URL Manager Pro in such a way so that it automatically opens when you launch 
your browser. Choose the Preferences command from the Diamond menu. Click the At Startup tab. 
Enable the 'Automatically launch URL Manager Pro' checkbox and use the Select button to specify 
which version of the URL Manager Pro application you actually want to be launched. 

CMM Plug-in (Mac OS X and Mac OS 9/8)
Included with URL Manager Pro is a Contextual Menu Manager (CMM) plug-in for Internet Explorer 
4.01 or higher, Eudora Pro 4.1 or higher, Claris Emailer 2.0v3, Outlook Express, and BBEdit. 

You will find it in the Add-Ons folder in the URL Manager Pro folder. This folder contains the plug-
in, called Add Bookmark, and a Read Me file. To install the CMM plug-in, please read the CMM 
plug-in Home Page. 

The CMM plug-in adds the command Add Link to URL Manager Pro to the Contextual Menu of 
Internet Explorer and iCab when you Control-Click a hypertext link. 

Tip: The Contextual Menu can also be activated by selecting one or more Bookmarks in the Favorites 
window of Explorer and pressing Control-Click. 

In addition, the CMM plug-in adds the command Add URL to URL Manager Pro to the Contextual 
Menu (accessed by Control-Click) of Eudora, Claris Emailer, Outlook Express and BBEdit. In fact, it 
will do this in any application that supports the Contextual Menu Manager. 

Sherlock
URL Manager Pro can tap the power of Sherlock to search your hard disk for words in Bookmark 
files. The commands Index File from the File menu and Find on Disk and Index Bookmarks from 
the Edit menu are all Sherlock related. 

By default, URL Manager Pro will assume that all your URL Manager documents (Bookmark files) 
are located in the Bookmarks folder in your Documents folder. See the Cabinet and Startup Items 
folder in the above parapgraphs for more information about the Bookmarks folder. You can then 
choose the Index Bookmarks from the Edit menu to index your Bookmark files quickly and 

http://www.url-manager.com/cmm.html
http://www.url-manager.com/cmm.html


conveniently. 

The Find on Disk command will search your Bookmarks folder for the words you enter in the Find on 
Disk dialog. 

 

You can, however, search your whole hard disk if you need to. In that case, enable the option 'Search 
All Online Volumes' in the Find On Disk dialog. 

To index your current Bookmark file, choose Index File from the File menu. Choose Index 
Bookmarks from the Edit to index all the files of the Bookmarks folder (including the 'Cabinet' and 
'Startup Items' folders). 

Note: You need to index the volume (hard disk) you want to search using the Find By Content section 
of the Sherlock program (in the Apple menu or Applications folder). 

With Mac OS 8.6 or higher, you can also index Bookmarks folder in the Finder. While holding down 
the Control key, select the Bookmarks folder in the Finder. Now choose the Index selection... 
command from the Contextual Menu. 

When using Sherlock to find keywords (you do not need to, because you can use the Find on Disk 
command in the Edit menu of URL Manager Pro, but I want to mention it for completeness) and it 
finds Bookmark files containing your query, choose Open Item from Sherlock's File menu or type 

 O. URL Manager Pro will open the Bookmark file and select the first bookmark that matches the 
query. Type  G (Find Again) to find the next bookmark. 

The Keychain
URL Manager Pro supports the Keychain feature of Mac OS 9 and higher. The Keychain provides a 
central secure database for storing passwords and the like. This information can be accessed by 
Keychain-enabled applications. 



URL Manager Pro is a Keychain-enabled application. You will be able, for example, to open 
password-protected Web pages for which the user ID and password are stored in the Keychain. URL 
Manager Pro will retrieve the user ID and password in Keychain automatically. You will also be able 
to save user ID and password information to Keychain via URL Manager Pro. 

To enable the Keychain support, switch on the Non Anonymous Access attribute in the Get Info 
Window of a Bookmark for a Web page that is password-protected. It will 'tell' URL Manager Pro to 
look up the user ID and password in the Keychain, whenever you try to access this bookmark. With 
the Add/Edit button, labeled Keychain, near the small Keychain icon in the lefthand side of the Get 
Info Window, you can edit and change the user ID and password for the Bookmark. 

Mac OS X Dock Menus
New in Mac OS X is the Dock, a application launch pad. URL Manager Pro is Dock-aware. Under 
Mac OS X, URL Manager Pro has an additional command in the Outline menu: Show in Dock (or 
Don't Show in Dock, when this command has been activated). 

By default, all of your bookmark folders and subfolders are visible when you click on the URL 
Manager Pro icon in the Dock. You can select a Bookmark and it will be loaded in the currently active 
application, such as your Web browser. This gives you complete access to all of your URL Manager 
Pro data from within your Internet applications. 

 

You can choose just to make a individual folders available via the Dock. Select a folder in the URL 
Manager Pro main window and use the command Show in Dock. Only this folder and its subfolders 
will be visible in Dock. This command can be used on multiple folders. 

To temporarily override the individual 'sharing' of folder, you can use the command Put whole 
document in Dock from the Outline menu. The will again 'share' the whole document as one large 
popup menu on the Dock. 

Note: The Show in Dock command is also available from the Folder Contextual menu. 

Note: The Put whole document in Dock command is also available from the Document Contextual 
menu. 





Command Key Shortcuts
Command Keys in URL Manager Pro: 

 A: Select All 

 B: Launch Web browser 

 C: Copy selected Bookmark or text to Clipboard 

 D: Move Bookmark Down 

 E: Launch HTML Editor 

 F: Find 

 G: Find Again 

 H: Show Helper Dock 

 I: Get Info 

 J: Edit in BBEdit 

 K: Add Web Page 

 L: Move Bookmark Left 

 M: Launch Email program 

 N: Create new Bookmark 

 O: Open Bookmark file 

 P: Print currently active Bookmark file. 

 Q: Quit URL Manager Pro 

 R: Move Bookmark Right 



 S: Save Bookmark file 

 T: Edit Favorites 

 U: Move Bookmark Up 

 V: Paste contents of Clipboard at cursor 

 W: Close Window 

 X: Cut currently selected text or Bookmark file 

 Z: Undo 

 ]: Expand all 

 [: Collapse all 

 D: Delete Duplicates 

 F: Find on Disk 

 H: Show History 

 N: New Folder 

 O: Open Bookmark 

Selecting

Drag across icons - Selects all icons in the group 

To select multiple contiguous Bookmarks, hold the Shift key while selecting them 

To select multiple non-contiguous Bookmarks, hold the Command key while selecting them 

Special Keys in URL Manager Pro

Option-Drag of a bookmark within a bookmark window
creates a duplicate of the bookmark 

Option-Drag of a bookmark to a text editor window (BBEdit for example)



creates a HTML anchor tag for the bookmark at the insertion point 
Option-Holding down on startup 

does not load items in Startup folder
Option-Click close box of window

closes all windows
Option-Return

creates a new bookmark
Control-Click close box of window 

closes a window without saving changes
Command-Down Arrow

opens the selected bookmark or folder
Command-Right Arrow

opens the selected folder
Command-Left Arrow

closes the selected folder
Option-Click Disclosure triangle

opens or closes a folder and its subfolders
Option-Double Click on a bookmark icon

opens the bookmark in the Web browser instead of helper
Control-Click: Bookmark/Folder/Document 

Contextual Popup Menu

Escape Key (Cancel) is implemented for most dialogs. 

Page Up, Page Down, Home and End Keys are supported 

Special Keys in the Mondriaan menu extra or 'menulet' (Mac OS X)

Using Control-Click on Mondriaan will let you choose the command 'Read Daily'. 

Making a menu selection and at the same time pressing the Option key, opens the bookmark in a new 
browser window. 

Special Keys in the Mondriaan Control Strip Module (Mac OS 9)

Using Control-Click on Mondriaan will let you reload its contents from the URL Manager Favorites 
file. 

Making a menu selection and at the same time pressing the Option key, opens the bookmark in a new 
browser window. 
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